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The information contained in this guide is intended to provide an overview of the optional UK Design
Module (UKDM) associated with the GASWorkS software.

Introduction

The UK Design Module contains features developed specifically to closely support the requirements of the
United Kingdom (UK) Institution of Gas Engineers guidance documents IGE/GL/1, IGE/TD/3, and
IGE/TD/4. The UKDM includes various common UK specific design methods and practices, and features
and routines which have been requested by past and current UK Users of GASWorkS.

The optional features associated with the UKDM include...

UKDM Features

Dimensional Units Conversion Utility - Allows a quantity in a specified dimensional unit (for example
length in Metres) to be converted to an equivalent value in another selected dimensional unit (for example
Feet).

Fuel/Energy Type Comparison & Conversion Utility - Allows a quantity in a specified fuel/energy type
(for example KW electricity) to be converted to an equivalent value in another selected fuel/energy type
(for example m3 of natural gas).

Diversity Calculator Utility - Allows calculation of diversified hourly loads based on specified heating
type, annual heating load, and customer count.

Pipe Segment Calculator - Allows calculation of various hydraulic values associated with flow in a single
pipe segment including pressure drop, maximum flow rate, minimum pipe size, maximum length, velocity,
and more.

Specialized Reports - Provides four specialized reports, known as the Main and Service Authorisation
Reports, and Main and Service Assumption Reports. The reports are saved in a comma separated values
(.csv) format that can be viewed and manipulated in many third party spreadsheet applications.

Pipe Property Table - Special handling of the Use When Sizing and Sizing Group items is provided in the
Pipe Property Table and Pipe Sizing routines.

Pipe Attributes - A custom linked pipe attribute file is provided to allow specialized handling of attributes
along a pipe/main feature. A special type of pipe vertex, known as a Pipe Attribute Marker, is provided
to allow segregating a pipe feature into multiple segments. Each segment can possess unique attribute
values. Special commands are provided to allow manipulation and management of the attribute markers.
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UKDM Features

Customer Attributes - A custom linked customer attribute file is provided to allow specialized handling
of attributes along a customer service line and associated with a customer. A special type of service vertex,
known as a Customer Attribute Marker, is provided to allow segregating a service line into multiple
segments. Each segment can possess unique attribute values. Special commands are provided to allow
manipulation of the attribute markers.

Custom Fittings - A set of specialized fittings are provided for use with the Service Sizing routines. This
feature allows a fitting to be specified by type (for example a 90-degree elbow), as opposed to a specific
size and type (for example a 63mm 90-degree elbow). The Sizing routine selects the appropriate size and
associated equivalent length value depending on the required service size.

Connections & Terminations - Similar to the custom fittings, connections and terminations can be
specified as a type (for example “Tapping Tee” or “House Entry”). The appropriate size and associated
equivalent length value, depending on the required service size, will be used during the Sizing routine.

Service Line Calculation - A set of special features, attributes, commands, and Calculation routines are
provided which support the calculation of the service line size, based on specified load data, configuration,
and sizing criteria. The routine supports calculation of “composite” (dual sized) services.

Special Graphic Display Features - Attribute segment numbers and a change in size symbol for composite
services can be displayed in the Graphic Data Interface (GDI) Window.

Special Plotting Features - A special map scale syntax is provided. A User defined Title Block can be
included with the plot output. A special editor is provided for creating and revising a Title Block
Definition.

Bill Of Materials - A routine is included to create a generic Bill Of Materials list for the associated
project. The list includes User specified fittings, connections, and terminations - and automatically
generated fittings, etc. The list can be viewed in GASWorkS or in any third party application that supports
the “.csv” file format.

Some UK Users may be familiar with GASWorkS 8.0. This version of GASWorkS was a custom version
only available to Fulcrum Connections and was never commercialized. Some of the features and data items
found in the UKDM version of GASWorkS 10 are similar to features and items found in GASWorkS 8.0,
however GASWorkS 10 does not wholly or completely duplicate the GASWorkS 8.0 features or data set.

In order to demonstrate and explain the features associated with the UKDM, this guide provides an example
which steps the User through the creation and analysis of a “project” using the UKDM features, followed
by documentation of the various UKDM features.

 B3PE LLC                                                                                          Engineering & Software Services
Revision - 002, Copyright 2021, All Rights Reserved.

2



GASWorkSTM 10.1 UK Design Module
Table Of Contents

Hardware/Software Requirements

GASWorkS UK Design Module will operate on any device configured to run Windows™ 8 thru Windows™
11. The GASWorkS UK Design Module software will require a minimum of 109 MB - of free hard disk
space when installed with full documentation.

Useful Commands

GASWorkS provides a number of GDI Commands for entering, editing, calculating, and displaying the
various model and supporting data associated with the design and analysis of a fuel piping system. Some of
the GDI Commands are listed below. Those denoted with an “*” are specific to the UK Design Module. A
full list of commands is included in the GASWorkS User’s Manual.

Add 2-Point Pipe
Add Feature To Group
Add Polyline Pipe
Add Service Governor*
Add User Graphic Line
Add User Graphic Symbol
Add User Text
Add User Text - With Leader Line
Copy Group
Copy Pipe
Copy Pipe - Offset*
Copy User Graphic Line
Copy User Graphic Symbol
Copy User Text
Create Bill Of Materials*
Create User Table
Delete Bill Of Materials Table*
Delete Group
Delete Pipe
Delete Polyline Pipe Vertex
Delete Service Governor*
Delete User Graphic Line
Delete User Graphic Symbol
Delete User Text

Display Isometric View
Display Plan View
Dissolve Group
Edit User Table
Move Group
Move Node
Move Node Text
Move Pipe Text
Move Polyline Pipe Vertex
Move User Graphic Line
Move User Graphic Symbol
Move User Text
Pan GDI Image
Plot GDI Image
Remove Feature From Group
Set Orthogonal Coordinates 
Set Orthogonal Coordinates - Plus
Snap Grid Intersections
Swap Pipe Ends
Tap Pipe
Trace
Trace & Update Data
Zoom To Fit
Zoom Window
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Getting Help - Contact Us

Hours - Our normal work hours are 8:00 A.M. to 5:00 P.M. Mountain Time, Monday through Friday.
However if you have a problem, please try at any time, we may be in.

By Telephone - (719) 578-9391

By Email - help@b3pe.com

By Website - www.b3pe.com
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The model and associated attribute files will sometimes be referred to as a “project” when
working with the UKDM features. As used in this example, in general, the term “model” refers
to the hydraulic configuration that represents the piping configuration and connectivity, and the
term “project” refers to the combination of the model data and attribute data.

Note...

In this example, a project will be developed for a simple piping system representing a small residential estate.
Customer locations and service lines will be included. Diversified loads will be used. The service lines and
main sizes will be calculated.

During the course of the example, the User will learn how to create a new project using the various UKDM
commands and features. The example assumes that the User is already familiar with the various data entry,
manipulation, display features, and commands associated with GASWorkS and specifically its Graphic Data
Interface (GDI) Window. If you are not already familiar with these features, work the example in the
GASWorkS Demonstration Guide before continuing with this example.

Create A New Project

If GASWorkS is not already started, start it now. If a model is already open, close it now using the Close item
from the File menu. The first step in creating a project is to create a new set of project files. To create a new
project...

! From the File menu, select the New Project item. The Project Specifications screen will be
displayed.

! Either accept the default Model Name or enter an appropriate name for the new project.

! Set the following values:

Template Model = Default
Preference Settings = Default
Default Settings = ukdm
Facility Settings = Default
Pipe/Main Sizing Table = pipe_uk
Service Sizing Table = pipe_uk
Attach A Linked Customer Attribute File = Select

File = ukdm_def_c
Attach A Linked Node Attribute File = Unselect
Attach A Linked Pipe Attribute File = Select

File = ukdm_def_p
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The project specification data can be saved to a file and opened for future use. This is useful
when creating a number of projects using similar default data values, etc. To save a specification,
click the Save command button. To open a previously saved specification, click the Open
command button.

Note...

! In the Background Image Files section, click the Select From Existing DXF Files command
button.

! The File Selection screen will be displayed. Use the Drives and Directories lists to
navigate to the GASWorkS 10\Files directory. Select the estate_plat.dxf file. Click the
Continue command button.

! On the Project Specifications screen, click the Continue command button to create the project and
open the GDI Window.
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The GDI Window will display differently on different monitors. If the screen is too large or too
small for your monitor, resize it now so that it fills your monitor. Click the Maximize GDI
Window icon from the GDI Window Controls Toolbar to fit the window to your monitor.
The width of the Data Panel can be changed and set by the User. From the Data Panel list, select
the Settings & Actions item, then select the Set Data Panel Width item. Enter a value by typing it in the GDI
Prompt Line. Ensure the value is expressed as a percentage of the computer screens width.

! Click the Zoom To Fit icon to adjust the model display to fit the new screen size.

Set The Graphic Settings

Some graphic settings and options should be set and selected in order to efficiently work the example. To
set and check the current graphic settings...

! From the Graphics menu, select the Settings item. The Graphic Settings screen will be displayed.

! In the Settings section, set the following values:

Customer Symbol Size = 3 % Of Display Width
Customer Symbol Style = Circle - Solid
Flow Arrow Size = 2 % Of Display Width
Node Symbol Size = 2 % Of Display Width
Pipe Line Thickness = 3
Pipe Symbol Size = 3 % Of Display Width
Refresh Increment = 10 % Of Image

! In the Options section, set the following options:

Allow Data Entry During New Feature Entry = Select
Automatically Pan & Zoom = Select
Display Flow Arrow Once Per Polyline Pipe = Select
Vary Resolution On Zoom = Select

! Click the Apply command button to close the screen and save changes.
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Set The Default Data Values

By selecting the “ukdm” file for the Default Settings in the Project Specifications, the default data values
should all be set correctly. However, it is always a good idea to check the settings before starting to enter
pipe, node, and customer data. To check the current default data settings...

! From the Utilities menu, select the Set Defaults item. The Default Data Values screen will be
displayed. On the Dimensional Units data tab, set the following:

Coordinates = Metres Node Load = M3h
Customer Load = M3h Pipe Flow Rate = M3h
Diameter = Millimetre Pressure = Millibar
Efficiency = Decimal Temperature = Celsius
Elevation = Metres Velocity = Metres/sec
Heating Value = MJ/m3 Viscosity = Centipose
Length = Metres

! The values on the Hydraulic Data tab, the Gas Properties data tab, and the Miscellaneous data
tab should be correct.

! Click the Close command button to close the screen and save changes.

Set The Property Table Settings

The Sizing routines are dependent on having the correct Property Tables selected. To set and check the
current Property Table settings...

! From the File menu, in the Preferences submenu, select the Property Tables item. The Property
Table Selection screen will be displayed. Set the following values:

Pipe = pipe_uk
Regulator = regulator
Compressor = compressor
Valve = valve
Well = well
Fittings = uk_fitting

Pipe Sizing Group = pipe_size_group_ukdm

! Click the Close command button to close the screen and save changes.
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Figure 1

Enter The Main Lines

The main lines will be entered by tracing over a background image. In general, the final main line
configuration should be similar to that in Figure 1. In Figure 1, the dots (solid circles) reflect node locations,
and the triangle symbols reflect the vertex locations (pipe deflection points).

Enter the first pipe segment from the supply point (Node SUPPLY) to the location of the first intersection
(Node TEE 1) using a polyline type pipe. See Figure 2.

! Click the Add Polyline Pipe icon from the Graphic Construction Commands Toolbar.

! For the From Node Location, move the mouse crosshairs to the desired
location and left-click the mouse.
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! The Node Data will be displayed in the Data Panel. In the Hydraulic Data Items section,
set the following values:

Name = SUPPLY
Pressure = 30
Pressure Units = Millibar
Pressure Known = Yes
Base Load = 0
Load Units = M3h
Base Load Known = No

! Click the Apply Data Values command button to save and apply the changes.

! For the Next Vertex prompts, draw the pipe lines by moving the mouse crosshairs to the
appropriate deflection points and the To Node Location, then left-click the mouse (see
Figure 1). After the To Node Location has been entered, right-click the mouse to end the
drawing process.

! The Node Data will be displayed in the Data Panel. In the Hydraulic Data Items section,
set the following values:

Node Name = TEE 1
Pressure = 0
Pressure Units = Millibar
Pressure Known = No
Base Load = 0
Load Units = M3h
Base Load Known = Yes

! Click the Apply Data Values command button to save and apply the changes.

! The Pipe Data will be displayed in the Data Panel.

! In the Pipe Sizing Items section, set the following values:

Allow Sizing = Yes
Sizing Group = MDPE

! In the Miscellaneous Data Values section, set the following values:

Facility Type = Main - Low Pressure
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Figure 2

! In the Attribute Data Values section, set the following values:

Link To Database = Yes
Address Street = Rectory Drive
Include In Report = Yes
Product Type = Lay To New

Segment 1 -
Surface Category - 1 = Open Trench
Ownership - 1 = Public
Orientation - 1 = Horizontal Below Ground
Joint Type - 1 = Butt Fusion
Packaging Type - 1 = Stick - 12 Metres
Reinstatement Method - 1 = None

! Click the Apply Data Values command button to save and apply the changes.

! Add the remaining main line piping using the various Graphic Construction, Zoom, and Pan commands.
Ensure that the adjacent pipe ends are “snapped” together by turning “on” the Feature Snap. For now, use
the default data values and settings for the remaining pipes and nodes, but change the node Names as
displayed on Figure 1. The completed piping system should look similar to Figure 1.
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With the exception of the node names and certain attribute values, the hydraulic and
attribute data values for a new pipe will default to the values entered for the last pipe
in the model. When entering new pipes, since the Allow Data Entry During New
Feature Entry graphic setting option has been selected, the appropriate values will be
displayed for the Pipe Data. If for some reason the data values need to be changed, use the Edit
Pipe Data command.

Note...

Figure 3

! To turn “on” the Feature Snap, click the Feature Snap icon from the lower-left corner of the
GDI Window until the icon is darkened. The Feature Snap will cause a new pipe end to be
snapped a node falling within the “target” symbol. Using the Feature Snap will help ensure that
the pipe ends are properly connected.

Enter Customer Locations

The customers will be entered using several techniques. A single polyline customer will be added, a set of
“dual” customers will be added, and multiple customers will be added using the “Auto Assign Main”
command. The resulting customer locations and service line configurations should be similar to Figure 3.
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Figure 4

Add A Polyline Customer

Enter the first customer as a polyline customer service. In this case, the service to Lot 37 will be entered as
a polyline type service as shown on Figure 4.

! Use the Zoom Window icon from the View Controls Toolbar to select a zoom window
around Lot 37 (in the upper-left/northwest corner of the estate).

! Click the Add Polyline Service Customer icon from the Customer Commands Toolbar.

! For the Main Tap Location, move the mouse crosshairs near the desired tap
location and left-click the mouse.

! For the Next Vertex prompts, draw
the service line by moving the mouse
crosshairs to the appropriate deflection
points (vertices) and the meter
location, then left-click the mouse (see
Figure 4). After the meter location has
been entered, right-click the mouse to
end the drawing process.

! The Customer Data will be
displayed in the Data Panel.

! In the Hydraulic Data Items section, set the following values:

Node Load Application = Diversified
Heating Type = Wet-Central Post 1976
Per Unit Load = -17500
Load Units = kWh

! In the Attribute Data Values section, set the following values:

Link To Database = Yes
Address Street = Rectory Drive
Address Number = 1
Alias = Lot 37
Include In Report = Yes
Hourly Demand = -3
Hourly Demand Units = M3h
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If the Use Last Record For Default Values preference setting option is selected, when
a new customer is added to the model, with the exception of certain attribute data, the
default hydraulic and attribute data for the new customer is taken from the data for the
last customer in the model. It is a good idea to make sure that the data for the first
customer is as desired. This will save data entry and revision time when constructing the model.
When entering new customers, if the Allow Data Entry During New Feature Entry graphic
settings option has been selected, enter appropriate values when the Customer Data is displayed
in the Data Panel, otherwise enter the values using the Edit Customer Data command.

Note...

Service Type = Single Service
Product Type = Lay To New
Allow Sizing Calculation = Yes - Composite Sized Service

Segment 1 -
Sizing Group - 1 = MDPE
Surface Category - 1 = Open Trench
Ownership - 1 = Private
Orientation - 1 = Horizontal Below Ground
Joint Type - 1 = Butt Fusion
Packaging Type - 1 = Coil - 100 Metres
Reinstatement Method - 1 = None

Connection Type = Tapping Tee
Termination Type = House Entry
Meter Type = U6
Housing Type = None
Allowable Pressure Drop = 2

! Click the Apply Data Values command button to save and apply the changes.

Add Branched/Dualed Customers

Branched or dualed customers consist of a trunk and a branch customer. Dualed customers are entered by
first entering the trunk customer, then entering the branch customer. In this case, the service to Lot 35 and
36 will be entered as a dualed service as shown in Figure 5. Lot 36 will be the trunk customer and Lot 35 will
be the branch customer.
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Figure 5

! Use the various Pan and Zoom commands as appropriate to make Lots 35 and 36 visible in the GDI
Display.

Enter the trunk customer (Lot 36) first. In this case, we will use a simple two-point style customer type.

! Click the Add Customer icon from the Customer Commands Toolbar.

! For the Customer Location (meter), move the mouse crosshairs near the desired
location and left-click the mouse.

! For the Supply Main, move the mouse pointer near the desired main and left-click the
mouse.

! The Customer Data will be displayed in the Data Panel. The default model data values
should be correct. Review and revise the attribute data as appropriate. If changes are made
click the Apply Data Values command button, or if no changes have been made click the
Continue command button or right-click the mouse.

Next, enter the branch customer (Lot 35).

! Click the Add Branch Customer icon from the Customer Commands Toolbar.

! For the Branch Customer Location, move the mouse crosshairs to the desired
location and left-click the mouse.

! For the Customer To Branch From, move the mouse pointer near the previously entered
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• The trunk portion of the dualed service can be entered using either a single two-point style
customer (as done in this example) or as a polyline style customer. If the trunk portion is entered
as a two-point style customer, it will automatically be converted to a polyline style customer
when the branch customer is attached to it.

• Once initially entered, vertex points can be added to either the trunk or branch portions of a
dualed service to more realistically represent the actual service configuration.

Note...

“trunk” customer (Lot 36) and left-click the mouse.

! For the New Tap Location, move the mouse crosshairs near the desired location and left-
click the mouse.

! The Customer Data will be displayed in the Data Panel. The default model data values
should be correct. Review and revise the attribute data as appropriate. If changes are made
click the Apply Data Values command button, or if no changes have been made click the
Continue command button or right-click the mouse.

Add Auto-Assigned Customers

Enter the remaining customers using the “Auto Assign Main” command. When using the “Auto Assign Main”
command, the customer location is selected by the User, and the supply main is automatically assigned to
the pipe geographically closest to the selected customer location. The Customer Data is only displayed for
the first customer when entering customers using the “Auto Assign Main” command. Enter the remaining
customers using the “Auto Assign Main” command (see Figure 3).

! Click the Add Multiple Customers - Auto Assign Main icon from the Customer
Commands Toolbar.

! For the Customer Location, move the mouse crosshairs near the desired location
for the first customer and left-click the mouse.

! The Customer Data will be displayed in the Data Panel. Review the data and make
changes as appropriate. The model data for the new customers will be the same as the
previously entered customers. If changes are made click the Apply Data Values command
button, or if no changes have been made click the Continue command button or right-click
the mouse.

! The Select Customer Location prompt will continue to be displayed. Add the locations
of the remaining customers by left-clicking the desired locations. After the last customer
location has been added, right-click the mouse.
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• In an actual project, vertices would probably be added to all of the service lines to more closely
indicate the actual service line routing and configuration. Attribute markers would probably be
added to all of the service lines to indicate changes in surface type, etc.

• Once entered, the customer locations, service line tap, deflection locations, and supply mains
can be altered or changed using the various Edit Customer Data commands.

• The graphic length of the service line is used as the basis for the base hydraulic length when
performing sizing and pressure drop calculations. If the lengths are not correct, appropriate values
can be manually entered for each segment of the service line using the “Pipe Length” item in the
customer Attribute Data Values.

• The tap location of two-point and auto-assigned customers is automatically selected
by GASWorkS. The location is calculated by attempting to force the service line to run
perpendicular from the main to the customer symbol location. Once entered, the tap
location for these types of customers can be manually relocated using the Move Service
Tap command. The tap location of polyline type customers is selected during the entry process.

Note...

Calculate The Main Sizes

In general, the GASWorkS Pipe Sizing routine requires three steps in order to perform correctly. The steps
include:

1) Establish which pipe sizes can be used during the Sizing process by creating a new or revising an
existing Pipe Property Table. The Pipe Property Table contains information about the pipe size and
material. The table entries are referenced to a Size/Type Code. A “standard” UKDM style Pipe
Property Table is installed when the software is installed. The table can be copied, modified, or
revised as desired by the User. The table should not need to be revised for this example. Additional
information on working with the Property Tables is provided later in this guide and in the
GASWorkS User’s Manual.

2) Establish which mains/pipes can be sized and what Sizing Group to associate them with.
Individual pipe segments may be set to allow sizing or not. The Property Table Report can be used
to review which sizes are allowed during the Pipe Sizing process. If a project contains both existing
mains and proposed mains, the existing mains would be set so that they are not included in the Pipe
Sizing process. In this example, all mains will be allowed to be sized. The Edit Pipe Data command
or Pipe Data Report can be used to review the allow sizing and Sizing Group settings.

3) Establish the pressure and velocity criteria. These values are set using the Pipe Sizing Control data
tab on the Solution Data screen.
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If the previous steps and settings described in this example have been followed correctly, the first two steps
should have already been completed. Use the following instructions to complete the third step, to solve and
calculate main/pipe sizes.

! Click the Solve icon from the lower-right corner of the GDI Window. The Solution Data
screen will be displayed. 

! On the Solution Data tab, set the following values:

Convergence Tolerance = 0.1 M3h
Reset Unknown Node Pressures To Zero = Select
Atmospheric Pressure = Handbook Of Chemistry & Physics
Diversity = IGE/GL/1 Appendix A5.1.5

! On the Other Settings data tab, set the following values:

Base Pressure = 1013.25 Millibar
Base Temperature = 15 Celsius

! On the Pipe Sizing Control data tab, set the following values:

Condition Nodes = (Empty)
Condition Pressure = (Empty)
System Pressures = 22 Millibar
Pressure Values Are = Minimums
Maximum Velocity = 20 Metres/sec

Pass Limit = 100 Number Of Passes
Path Processing = Flow-Pressure Drop Processing
Optimize By = Size
Facility Type = Main - Low Pressure
Reset Diameters To Minimum Size = Select
Pipe Sizing Table = pipe_uk

! Click the Solve & Calculate Pipe Sizes command button.
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• The Solution Log displays the progress of the Solution process. During a normal solution, the
node errors should start relatively large and get smaller as the solution progresses, until the node
error is less than the specified Convergence Tolerance. The last line of the Solution Log should
indicate that the pipe sizing and solution are “complete”. The last line should display “Pipe Sizing
Complete”. If the solution is not complete, recheck the project/model creation steps, correct any
errors you encounter, then re-solve and recalculate the model.

• The actual values reported on the Solution Log will vary from those displayed because of the
different hydraulic lengths, which are a result of manually adding the pipe configuration and
customer assignments.

• For more information on the Pipe Sizing process, refer to the GASWorkS User’s Manual.

Note...

! While the solution is being
performed, the Solution Log will be
displayed. The Solution Log displays
the solution activity and informs the
User when the solution and Pipe Sizing
process is complete. Upon completion
of the solution, review the last few
lines of the Solution Log - they should
indicate that the pipe sizing was
successfully completed. Click the
Close command button to close the
Solution Log and return to the GDI
Window.

If the solution was successfully
completed, the Solve icon will change
when the Solution Log is closed. The
balance scale image on the icon will
display in a balanced position if the
solution was successful, indicating that
the model status is balanced.

View The Analysis Results

After the solution has successfully been completed, the resulting node pressure values and pipe sizes can be
viewed individually using the Edit Pipe Data or Edit Node Data commands, or the values can be displayed
in the GDI Window. To display the results:
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! Click the Text Display Settings icon from the Display Controls Toolbar. The Text
Display Settings screen will be displayed.

! On the Pipe Items data tab, set the following values:

Display Pipe Text Items = Select
Text Color = Dark Color

Note - To set a Color, click in the color box. The Color Palette will be
displayed. Select the desired color, then click the OK command button.

Pipe Size/Type Code = Select
Pipe Velocity = Select

! On the Node Items data tab, set the following values:

Display Node Text Items = Select
Node Pressure = Select

! Click the Apply command button to apply the changes to the display.

To make the display of the results more readable...

! Turn “off” the customer symbol display by clicking the Display Customer Symbols icon
on the Customer Commands Toolbar. Click the icon until the symbol display is turned
“off”.

! If the text is not already displayed opaquely, turn “off” the transparent text display.
Click the Text Display Settings icon from the Display Controls Toolbar. The Text
Display Settings screen will be displayed. On the various data tabs, unselect the
Transparent Font option. Click the Apply command button to save and apply the changes.

The pressure values, flow directions, and pipe sizes should be similar to those shown in Figure 6.
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• As a result of the “hand drawn” pipe segments, each example model is created slightly different.
Therefore the results will be slightly different for each model. The results, however, should be
similar to those shown in Figure 6.

• The displayed pressure values represent the estimated pressure for each node point. The velocity
values indicate the maximum estimated velocity for the associated segment.

Note...

Figure 6
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• The pressure and velocity limits set in the Pipe Sizing Control data (Solution Data screen)
establish the maximum and minimum acceptable limits for the associated values. After the Pipe
Sizing routine has successfully been completed, the pressure values should all be greater than or
equal to the specified system pressures value, and the velocities should all be less than or equal
to the specified maximum velocity value.

• Because actual pipe sizes are used, as opposed to theoretical internal diameters, seldom will the
pressures or velocities exactly equal the specified limit values.

• You may want to move the text values so the display is more readable. Use the Move Pipe Text
or Move Node Text commands to reposition the associated text values.

Note...

• To calculate the service size for an individual customer, select a customer, then select the
Calculate All Service Sizes item from the Actions section of the Customer Data in the Data Panel.

• The services are calculated using the methods described later in this guide.

• Although the “composite size” option was set for all of the services, there were no composite
results from the Pipe Sizing process because the lengths are too short.

Note...

Calculate The Service Sizes

If the results of the Pipe Sizing process are acceptable, the service sizes can then be calculated. The main
sizes and system pressures should always be established before using the Service Sizing routine.

! To size all of the services, click the Calculate All Service Sizes icon from the lower-right corner
of the GDI Window. A message may be displayed when the calculation is complete. Click the OK
command button to clear the message.

! If the customer symbols were previously turned “off”, turn the customer symbols back “on” by
clicking the Display Customer Symbols icon from the Customer Commands Toolbar. Click the icon
until the customer symbols are displayed.

! View the sizing results using the Edit Customer Data command. If the service sizes are not as
expected, double-check the customer data entry and recalculate the service sizes.

This last task concludes the example. The remainder of this guide describes the various data screens, data
items, methods, and features unique to the UKDM.
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This section provides a general description and reference for using the menu items unique to the UK Design
Module. Grouped by functional topic, procedures are described for using each of the menu items available
in the menu lists. Most of the menu items will launch a data screen or specification screen. Further
information describing the use of those screens is provided in the following sections of this guide. Note -
Certain menu items will not be displayed if a model is not open.

Edit - Enter & Edit Data

The following UKDM menu items are included in the Edit menu. The routines found in the Edit menu are
described in the following sections.

Title Block Definition - View/Edit The Title Block Definition

The Title Block Definition item provides access to the Title Block Definition screen. To view or edit the Title
Block Definition...

! From the Edit menu, select the Title Block Definition item.

! The File Selection screen will be displayed. Either enter the desired name in the Filename data
field, or select an existing name from the Files list. If a valid file name has not been found, a
message will be displayed asking to create the file - respond appropriately. When a valid file name
has been entered, click the Continue command button.

! The Title Block Definition screen will be displayed. Make any desired changes, then click the
Close command button to close the screen.

Notes & Considerations

! See the Title Block Definition Screen topic in the Data Screens section for a detailed description of its
features.
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Analysis - Calculating Values

The following UKDM menu items are included in the Analysis menu. The routines found in the Analysis
menu are described in the following sections.

Calculate Conversion - Dimensional Unit & Fuel Type Conversions

The Calculate Conversion item displays the Conversion Calculator screen. To calculate a conversion...

! From the Analysis menu, select the Calculate Conversion item.

! The Conversion Calculator screen will be displayed.

! For Dimensional Unit conversions, on the Dimensional Units data tab, enter the Known
Value (quantity) and select the associated dimensional unit. Select the desired Converted
Value dimensional unit. The calculation will be performed when either the Enter key is
pressed in the Known Value data field, or a new dimensional unit is selected from either
dimensional units list.

! For Fuel Type conversions, on the Fuel Types data tab, enter the Known Value (quantity),
select the associated dimensional unit, and select the associated fuel type. Select the desired
Converted Value dimensional unit and fuel type. The calculation will be performed when
either the Enter key is pressed in the Known Value data field, or a new dimensional unit or
fuel type is selected from either of the dimensional units or fuel type lists.

! Click the Close command button to close the screen.

Notes & Considerations

! See the Conversion Calculator Screen topic in the Data Screens section for a detailed description of its
features.
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Calculate Diversity - Calculate Hourly Usage

The Calculate Diversity item displays the Diversity Calculator screen. To calculate hourly usage from annual
usage data...

! From the Analysis menu, select the Calculate Diversity item.

! The Diversity Calculator screen will be displayed. Click the Clear command button to reset any
previously entered values.

! Select the Annual Usage and Hourly Usage dimensional units.

! Select a Diversity Calculation Method.

! For each Housing Style, enter the associated Annual Usage value and the Customer Count.

! The calculation will be performed when either the Enter key is pressed in one of the data
fields, when one of the dimensional units is changed, or when the Calculate command
button is clicked.

! Click the Close command button to close the screen.

Notes & Considerations

! See the Diversity Calculator Screen topic in the Data Screens section for a detailed description of its
features.

Calculate Pipe Segment Values - Calculate Pipe Flow Values

The Calculate Pipe Segment Values item displays the Pipe Segment Calculator screen. To calculate pipe flow
and pressure values...

! From the Analysis menu, select the Calculate Pipe Segment Values item.

! The Pipe Segment Calculator screen will be displayed.

! Any of the items with a red colored label may be calculated. Select the desired item to be
calculated by clicking on the associated label (that label will be underlined). The item that
is underlined is the item that will be calculated.
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! Select the desired dimensional units. Enter the various known data values. Note - See the
Pipe Segment Calculator screen description later in this guide for more information on the
use of fittings or calculating pipe sizes.

! Click the Calculate command button to calculate the specified item and display the
various other calculated values.

! Click the Close command button to close the screen.

Notes & Considerations

! See the Pipe Segment Calculator Screen topic in the Data Screens section for a detailed description of its
features.
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Report - Reporting Values

The following UKDM menu items are included in the Report menu. The routines found in the Report menu
are described in the following sections.

Assumption & Authorisation

The Assumption & Authorisation item displays a specially formatted report known as the Assumption &
Authorisation Report. To display the report...

! From the Report menu, select the Assumption & Authorisation item.

! The Assumption & Authorisation Report will be displayed. Select the data tab associated with the
facility and report type to be viewed. The report contents can be scrolled and printed similar to other
GASWorkS reports.

! Click the Close command button to close the report.

Notes & Considerations

! See the Assumption & Authorisation Report topic in the Data Screens section for a detailed description
of its features.

Bill Of Materials

The Bill Of Materials item generates and displays a Bill Of Materials Report for the associated project. To
display the report...

! From the Report menu, select the Bill Of Materials item.

! Note - If a Bill Of Materials Report already exists for the model, a message will be displayed
asking whether to recreate the Bill Of Materials - respond accordingly.

! The Bill Of Materials Report will be displayed. Select the data tab associated with the materials
type to be viewed. The report contents can be scrolled and printed, similar to other GASWorkS
Reports.

! Click the Close command button to close the report.
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Notes & Considerations

! See the Bill Of Materials Report topic in the Data Screens section for a detailed description of its features.
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The previous section described the function of the unique UK Design Module menu items. In that section,
several data screens and specification screens were introduced. This section provides a detailed description
of those screens.

Instructions for negotiating the data screens, and for entering and selecting data values, are provided in the
General Information section of the GASWorkS User’s Manual. The following pages present a description
for each of the unique screens used with the UK Design Module. The descriptions are listed in alphabetical
order based on the screen name.

Assumption & Authorisation Report

The Assumption & Authorisation Report routine creates a multi-tabbed report, where each data tab represents
a separate section of the report. To view the report, select the Assumption & Authorisation item from the
Report menu. The features associated with the report are described as follows.

Main Assumptions Tab

Displayed Items

Facility Type - Specifies the assigned Facility Type of the main that the customer is attached to. The
customer inherits the same Facility Type as the assigned main.

From Node - Specifies the name of the beginning node of the associated main feature.

Length - Specifies the hydraulic length for a main feature. The value is expressed in the Length Unit.
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Length Unit - Specifies the length dimensional units for the associated main feature.

To Node - Specifies the name of the ending node of the associated main feature.
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Service Assumptions Tab

Displayed Items

Length - Specifies the length for a service feature. The value is expressed in the Length Units.

Length Units - Specifies the length dimensional units for the associated service feature.

Load - Specifies the load value for each customer “unit”. A negative value indicates a demand (flow leaving
the system), and a positive value indicates a supply (flow entering the system). The value is expressed in the
Load Units.

Load Units - Specifies the dimensional units for the Load value.

 B3PE LLC                                                                                          Engineering & Software Services
Revision - 002, Copyright 2021, All Rights Reserved.

37



GASWorkSTM 10.1 Data Screens
Table Of Contents

Main Authorisation Tab

Displayed Items

Customer Count - Specifies the number of customers attached to the associated main feature.

Facility Type - Specifies the assigned Facility Type of the main that the customer is attached to. The
customer inherits the same Facility Type as the assigned main.

Flow Rate - Displays the calculated flow rate value. A positive value indicates that the flow direction is from
the From Node to the To Node, and a negative value indicates that the flow direction is from the To Node
to the From Node. The value is expressed in the Flow Units.

Flow Units - Specifies the dimensional units of the flow rate value.

From Node - Specifies the name of the beginning node of the associated main feature.

Inlet Pressure - Specifies the inlet pressure value for the associated main feature. The value is expressed
in the Pressure Units.

Length - Specifies the hydraulic length for a main feature. The value is expressed in the Length Unit.

Length Unit - Specifies the length dimensional units for the associated main feature.

Outlet Pressure - Specifies the outlet pressure value for the associated main feature. The value is expressed
in the Pressure Units.
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Pressure Drop - Displays the linear pressure drop across a main segment or device (the From Node Pressure
minus the To Node Pressure). Note - When elevation differences are present along the main segment, it is
possible for the downstream pressure to be larger than the upstream pressure. A positive value indicates that
the From Node pressure is larger than the To Node pressure, and a negative value indicates that the To Node
pressure is greater than the From Node pressure.

Pressure Units - Specifies the dimensional units of the pressure values.

To Node - Specifies the name of the ending node of the associated main feature.

Velocity - Specifies the maximum velocity of the gas flow in the main feature. The value is expressed in the
Velocity Units.

Velocity Units - Specifies the dimensional units of the velocity value.
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Service Authorisation Tab

Displayed Items

Heating Type - Specifies the space heating type when “Diversified” is selected for the Node Load
Application.

Hourly Load - Specifies the... The value is expressed in the Hourly Load Units.

Hourly Load Units - Specifies the hourly load dimensional units for the associated service feature.

Inlet Pressure - Specifies the inlet pressure value for the associated service feature. The value is expressed
in the Pressure Units.

Length - Specifies the length for a service feature. The value is expressed in the Length Units.

Length Units - Specifies the length dimensional units for the associated service feature.

Outlet Pressure - Specifies the outlet pressure value for the associated service feature. The value is
expressed in the Pressure Units.

Pressure Drop - Displays the linear pressure drop across the service main segment.

Pressure Units - Specifies the dimensional units of the pressure values.

Velocity - Specifies the maximum velocity of the gas flow in the service feature. The value is expressed in
the Velocity Units.
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Velocity Units - Specifies the dimensional units of the velocity value.

Icons

Maximize Screen Size - Increases the Assumption & Authorisation Report’s size to fill the
GASWorkS display.

Print - Prints the contents of the currently displayed data tab. When clicked, the Print Settings
screen is displayed.

Reset Screen Size - Sets the Assumption & Authorisation Report’s size to its “normal”
dimensions and position.

Command Buttons

Close - Closes the Assumption & Authorisation Report.

Notes & Considerations

! The contents of the report are derived from the various hydraulic and attribute data associated with the
pipes/mains and customers in the model.

! The contents of the report are saved in a comma separated values (*.csv) format file which can be opened,
viewed, and edited in any third party application that supports that file type (for example, Microsoft Excel).
Each section of the report is stored in an individual file. The files are named the same as the model but
possess a double extension as follows:

Extension File Type

.car.csv Service (Customer) Authorisation Report

.cas.csv Service (Customer) Assumption Report

.mar.csv Main (Pipe) Authorisation Report

.mas.csv Main (Pipe) Assumption Report
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! If the contents or format of the report are changed by a third party application and saved to the original
name, the contents may not be viewable in GASWorkS.

! If the report gets hidden behind another open screen or window, make the report activate (the window on
the top of the report stack) by clicking on any visible portion of the report’s screen, or select the report’s
name from the Window menu.

! Normally the report will contain more information than will fit on a single page. If this condition occurs
when trying to print, a message will be displayed. When the message is displayed, respond appropriately.
To print a report that is too wide for the printer, either set the printer to use Landscape Orientation, or reduce
the printer font size.

! The Include In Report item in the Attribute Data Values of the associated data, controls which pipe and
customer features are included in the report. Only pipes or customers were the Include In Report item is set
to “Yes”, are included in the report.

 B3PE LLC                                                                                          Engineering & Software Services
Revision - 002, Copyright 2021, All Rights Reserved.

42



GASWorkSTM 10.1 Data Screens
Table Of Contents

Bill Of Materials Report

The Bill Of Materials routine creates a Bill Of Materials Report and displays a multi-tabbed report, where
one data tab represents the pipe/main materials and the other data tab represents the service/customer
materials. To display the report, either select the Bill Of Materials item from the Report menu or select the
Create Bill Of Materials command. The features associated with the report are described as follows.

Displayed Items

FACILITY - Displays the Facility Type assigned to the associated item.

ITEM_CODE - Displays a code that identifies the type of item associated with the current record in the list.
Items associated with mains begin with a “M”, and items associated with services begin with a “S”. See the
following Notes & Considerations section for descriptions of the possible “ITEM _CODE” items.

ITEM_TYPE - Displays a short description for the associated item. For example, it might contain “Tapping
Tee” for a connection type item.

JOINT - Displays the joint attribute value assigned to the associated item.

ORIENTATION - Displays the orientation attribute value assigned to the associated item.

OWNER - Displays the owner attribute value assigned to the associated item.
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PACKAGE - Displays the package attribute value assigned to the associated item.

PRODUCT - Displays the product attribute value assigned to the associated item.

QUANTITY - Displays the total number of items found matching the attributes associated with the item
group (ITEM_CODE). The quantity is expressed in terms of the indicated Units Of Measure (UOM).

REINSTATEMENT - Displays the reinstatement attribute value assigned to the associated item.

SIZE/TYPE_1 - Displays the primary pipe size type of the associated item as shown in the following tables
in the Notes & Considerations section.

SIZE/TYPE_2 - Displays the secondary pipe size type of the associated item as shown in the following
tables in the Notes & Considerations section.

SURFACE - Displays the surface attribute value assigned to the associated item.

UOM - Displays the Units Of Measure (UOM) for the associated QUANTITY data field.

Icons

Insert As Table - Inserts the Bill Of Materials Report content as a User Table feature into the
model image.

Maximize Screen Size - Increases the Bill Of Materials Report’s size to fill the GASWorkS
display.

Print - Prints the contents of the currently displayed data tab. When clicked, the Print Settings
screen is displayed. 

Reset Screen Size - Sets the Bill Of Materials Report’s size to its “normal” dimensions and
position.

Restore Columns - Restores the display of all of the columns (data items). When clicked, all of
the columns associated with the current data tab will be displayed.
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Set Columns - Used to specify which columns (data items) are displayed in the Bill Of Materials
Report. When clicked, the Columns specification screen is displayed.

View In Spreadsheet Application - Displays the Bill Of Materials Report contents in the
application currently assigned to the “.csv” file format in the default system application assigned
to the “.csv” file type. When clicked, the assigned application will open and display the contents
of the Bill Of Materials Report.

Command Buttons

Close - Closes the Bill Of Materials Report.

Notes & Considerations

! The contents of the report are derived from the various hydraulic and attribute data associated with the
pipes, mains, customers, and services in the model.

! The contents of the report are saved in a comma separated values (.csv) format file which can be opened,
viewed, and edited in any third party application that supports that file type (for example, Microsoft Excel).
The file is named the same as the model but possesses a “.bom.csv” extension. The “.bom.csv” file can also
be used as a source for additional processing by a third party application.

! If the contents or format of the report are changed by a third party application and saved to the original
name, the contents may not be viewable in GASWorkS.

! If the report gets hidden behind another open screen, make the report activate (the window on the top of
the report stack), by clicking on any visible portion of the report’s screen, or select the report from the
Window menu.

! The columns in the Bill Of Materials Report represent the total quantity of the specified item found in the
model, grouped by various attributes. For example, the total quantity of “63mm MDPE SDR...” pipe assigned
to “Public” ownership (OWNER). The format of the report will vary depending on whether a UKDM
attribute file is attached to the model. If a UKDM attribute file is attached, only pipe or customer features
where the Include In Report item is set to “Yes” are included in the Bill Of Materials Report.

! Normally the report will contain more information than will fit on a single page. If this condition occurs
when trying to print, a message will be displayed. When the message is displayed, respond appropriately.
To print a report that is too wide for the printer, either eliminate some of the undesired columns using the
Set Columns routine or by manually collapsing the undesired columns, set the printer to use Landscape
Orientation, or reduce the printer font size.
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! The meanings of the “ITEM_CODE”, “SIZE/TYPE_1”, and “SIZE/TYPE_2” items for main type features
are described in the following table.

Main Materials

ITEM_CODE Notes

MCOMP Description Compressor

SIZE/TYPE_1 Represents the Size/Type Code of the compressor.

SIZE/TYPE_2 Not used

Derivation
Method

This item is derived for pipes assigned as a Compressor Hydraulic
Type.

Notes • The ITEM_TYPE column is not populated for this item.
• The FACILITY column is populated for this item.

MCONA Description Connection - Automatic Generation

SIZE/TYPE_1 Size/Type Code of the larger pipe.

SIZE/TYPE_2 Size/Type Code of the smaller pipe.

Derivation
Method

• For a node with only two pipes connected to it, this item is derived
as the connection between the two adjacent pipes.
• For a node with three connections, a tee is derived for the most
common or the largest size when no common sizes are present. The
tee is assumed to be connected to one of the pipes. This item is
derived as the connection between the two non-tee pipes to the
derived tee. The tee is listed as a MTEEA.
• For a node with more than three connections, a tee is derived for
the largest connected pipe size. The tee is assumed to be connected
to the largest pipe. This item is derived as the connection between
the remaining pipes and the derived tee. The tee is listed as a
MTEEA.
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Main Materials

ITEM_CODE Notes

MCONU Description Connection - User Assigned

SIZE/TYPE_1 Represents the value assigned to the “Connection Size” attribute
data item.

SIZE/TYPE_2 Represents the size of the pipe that the connection is assigned to.

Derivation
Method

Derived from the value assigned to the “Connection Type” attribute
data item.

Notes • The ITEM_TYPE column indicates the assigned value
(“Connection Type”).
• The FACILITY column is populated for this item.

MFITU Description Fitting - User Assigned

SIZE/TYPE_1 Represents the Size/Type Code of the assigned fitting.

SIZE/TYPE_2 Not used

Derivation
Method

• Pipe Hydraulic Type - Derived from the fittings assigned to an
attribute segment.
• Valve Hydraulic Type - Derived from the pipes assigned to the
Valve Hydraulic Type.

Notes • The ITEM_TYPE column is not populated for this item.
• The FACILITY column is populated for this item.

MJNTA Description Pipe Joint - Automatically Generated

SIZE/TYPE_1 Represents the Size/Type Code of the associated pipe.

SIZE/TYPE_2 Not used

Derivation
Method

Derived as the summation of the joints required for each individual
main, based on the value assigned to the “Joint Type” and
“Packaging Type” attribute data items.

Notes The ITEM_TYPE column indicates the assigned value (“Joint
Type”).
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Main Materials

ITEM_CODE Notes

MPIPE Description Pipe

SIZE/TYPE_1 Represents the Size/Type Code of the associated pipe.

SIZE/TYPE_2 Not used

Derivation
Method

Derived by summing all of the main pipes with similar size and
attribute values.

Notes The ITEM_TYPE column is not populated for this item.

MREG Description Governor

SIZE/TYPE_1 Represents the Size/Type Code of the governor.

SIZE/TYPE_2 Not used

Derivation
Method

This item is derived for pipes assigned to the Governor Hydraulic
Type.

Notes • The ITEM_TYPE column is not populated for this item.
• The FACILITY column is populated for this item. 

MTEEA Description Multiple Main Connection

SIZE/TYPE_1 Represents the Size/Type Code of the associated pipe.

SIZE/TYPE_2 Not used

Derivation
Method

• For a node with three connections, this item is derived for the most
common, or the largest size when no common sizes are present. The
tee is assumed to be connected to the largest pipe, or any one of the
pipes, if all pipes have a common size and type. A MCONA item is
derived for the other two pipe connections.
• For a node with more than three connections, this item is derived
for the largest connected pipe size. The tee is assumed to be
connected to the largest pipe. A MCONA item is derived for the
other connected pipes.
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Main Materials

ITEM_CODE Notes

MTRMA Description Main Termination

SIZE/TYPE_1 Represents the Size/Type Code of the associated pipe.

SIZE/TYPE_2 Not used

Derivation
Method

For a node with a single pipe connection, this item is derived as the
termination of the pipe, regardless of the load value. In other words,
a termination is derived for each pipe end not connected to another
pipe, regardless of whether it is a load or demand point.

MVLVN Description Valve Node

SIZE/TYPE_1 Represents the Size/Type Code of the pipe that the valve node is
assigned to.

SIZE/TYPE_2 Not used

Derivation
Method

This item is derived for each valve node assigned it a pipe.

Notes The FACILITY column is populated for this item.

MVLVU Description Valve

SIZE/TYPE_1 Represents the Size/Type Code of the associated valve.

SIZE/TYPE_2 Not used

Derivation
Method

This item is derived for pipes assigned to the Valve Hydraulic Type.

Notes • The ITEM_TYPE column is not populated for this item.
• The FACILITY column is populated for this item.
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Main Materials

ITEM_CODE Notes

MWELL Description Well

SIZE/TYPE_1 Represents the Size/Type Code of the associated well.

SIZE/TYPE_2 Not used

Derivation
Method

This item is derived for pipes assigned to the Well Hydraulic Type.

Notes • The ITEM_TYPE column is not populated for this item.
• The FACILITY column is populated for this item.

! The meanings of the “ITEM_CODE”, “SIZE/TYPE_1”, and “SIZE/TYPE_2” items for service type
features are described in the following table.

Service Materials

ITEM_CODE Notes

SCONA Description Connection - Automatic Generation

SIZE/TYPE_1 • Composite - Represents the larger composite size.
• Branch - Represents the size of the trunk portion of the
branch service.

SIZE/TYPE_2 • Composite - Represents the smaller composite size.
• Branch - Represents the size of the branch portion of the
branch service.

Derivation
Method

• Composite - Derived as the connection between the two
composite sizes.
• Branch - Derived as the connection from the trunk tee to the
downstream branch portion. A tee is derived for the trunk at the
branch connection. The trunk tee is reported as a STEEA item.

Notes The ITEM_TYPE column indicates whether the item is
associated with a composite or branch style service.
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Service Materials

ITEM_CODE Notes

SFITU Description Fitting - User Assigned

SIZE/TYPE_1 Represents the size of the segment the fitting is assigned to. For
composite services where the size changes along the associated
segment, the value represents the larger size.

SIZE/TYPE_2 Not used

Derivation
Method

Derived from the fittings assigned to an attribute segment.

Notes The ITEM_TYPE column indicates the assigned value
(“Attached Fittings” type).

SGOV Description Governor

SIZE/TYPE_1 Not used

SIZE/TYPE_2 Not used

Derivation
Method

Derived from the value assigned to the “Governor Type”
attribute data item.

Notes • The ITEM_TYPE column indicates the assigned value
(“Governor Type”).
• The FACILITY column is populated for this item.

SHSNG Description Meter Housing

SIZE/TYPE_1 Not used

SIZE/TYPE_2 Not used

Derivation
Method

Derived from the value assigned to the “Housing Type”
attribute data item.

Notes The ITEM_TYPE column indicates the assigned value
(“Housing Type”).
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Service Materials

ITEM_CODE Notes

SJNTA Description Pipe Joint - Automatically Generated

SIZE/TYPE_1 Represents the value of the associated pipe.

SIZE/TYPE_2 Not used

Derivation
Method

Derived as the summation of the joints required for each
individual service segment, based on the value assigned to the
“Joint Type” and “Packaging Type” attribute data items.

Notes The ITEM_TYPE column indicates the assigned value (“Joint
Type”).

SMETR Description Meter

SIZE/TYPE_1 Not used

SIZE/TYPE_2 Not used

Derivation
Method

Derived from the value assigned to the “Meter Type” attribute
data item.

Notes • The ITEM_TYPE column indicates the assigned value
(“Meter Type”).
• The FACILITY column is populated for this item.

SPIPE Description Pipe

SIZE/TYPE_1 Represents the pipe Size/Type Code.

SIZE/TYPE_2 Not used

Derivation
Method

Derived by summing all of the service pipes with similar sizes
and attribute values.

Notes Except for the ITEM_TYPE column, all fields are populated
for this item.
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Service Materials

ITEM_CODE Notes

STAPU Description Service To Main Connection

SIZE/TYPE_1 Represents the Size/Type Code of the first segment of the
service line.

SIZE/TYPE_2 Represents the Size/Type Code of the main that the service line
is connected to.

Derivation
Method

Derived from the value assigned to the “Connection Type”
attribute data item.

Notes The ITEM_TYPE column indicates the assigned value
(“Connection Type”).

STEEA Description Trunk To Branch Connection

SIZE/TYPE_1 Represents the Size/Type Code of the segment of the trunk
portion of the branch service, where the branch portion
connects to the trunk.

SIZE/TYPE_2 Not used

Derivation
Method

Derived as the size of the trunk portion of the branch service,
where the branch portion connects to the trunk.

Notes The ITEM_TYPE column indicates that the item is associated
with a trunk service.

STERM Description Termination

SIZE/TYPE_1 Represents the Size/Type Code of the last segment of the
service line.

SIZE/TYPE_2 Not used

Derivation
Method

Derived from the value assigned to the “Termination Type”
attribute data item.

Notes • The ITEM_TYPE column indicates the assigned value
(“Termination Type”).
• The FACILITY column is populated for this item.
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Conversion Calculator

A routine is provided to convert quantities and fuel type values from one dimensional unit to another. To
perform a conversion, select the Calculate Conversion item from the Analysis menu. The features associated
with the screen are described as follows.

Dimensional Units Tab

Data Items

Converted Value -

Dimensional Units - Specifies the dimensional unit to convert the known value to.

Known Value -

Dimensional Units - Specifies the dimensional unit associated with the quantity to be converted. 

Quantity - Specifies the quantity to be converted.

Calculated Items

Converted Value -

Quantity - Displays the known quantity value, converted to an equivalent quantity in the specified
dimensional units.
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Fuel Types Tab

Data Items

Converted Value -

Dimensional Units - Specifies the dimensional unit to convert the known value to.

Fuel Type - Specifies the fuel type to convert the known value to.

Known Value -

Dimensional Units - Specifies the dimensional unit associated with the quantity to be converted. 

Fuel Type - Specifies the fuel/energy type of the quantity to be converted.

Quantity - Specifies the quantity to be converted.

Calculated Items

Converted Value -

Quantity - Displays the known quantity value, converted to an equivalent quantity in the specified
dimensional units and fuel/energy type.
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Command Buttons

Close - Closes the screen.

Notes & Considerations

! The conversion calculation is performed when a quantity value is changed and the Enter key is pressed,
or when a new item is selected from the dimensional units or fuel type lists.

! The number of digits displayed to right of the decimal indicator for the calculated converted quantity value
is set to one more digit than the number of decimal digits entered for the known quantity value.
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Diversity Calculator Report

The Diversity Calculator Report is accessed by clicking the Print command button on the Diversity
Calculator screen. The features associated with the report are described as follows.

Displayed Items

Diversity Calculator Report - Displays the Diversity Calculator Report. To browse the display, adjust the
vertical scroll bar adjacent to the display area.

Icons

Copy To Clipboard - Copies the contents of the Diversity Calculator Report to the Windows
Clipboard. Once copied, the contents may be pasted into another application.

Maximize Screen Size - Increases the Diversity Calculator Report’s size to fill the GASWorkS
display.
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Print - Displays the Print Settings screen and allows contents of the Diversity Calculator Report
to be printed.

Reset Screen Size - Sets the Diversity Calculator Report’s size to its “normal” dimensions and
position.

Command Buttons

Close - Closes the Diversity Calculator Report.

Notes & Considerations

! If the Diversity Calculator Report is too wide to print, set the printer to use landscape mode, and reduce
the printer font size. If no adjustment is made to the report’s width, the report will be printed on multiple
pages.
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Diversity Calculator

A routine is provided to calculate diversified load values from specified annual usage values. To use the
calculator, select the Calculate Diversity item from the Analysis menu. The features associated with the
screen are described as follows.

Data Items

Annual Usage - Specifies the annual usage value for the associated housing/heating style.

Customer Count - Specifies the number of customers associated with the associated housing/heating style.

Diversity Calculation Method - Specifies the diversity calculation method.

Hourly Usage Units - Specifies the dimensional unit associated with the hourly usage value.

Calculated Items

Hourly Usage Per Customer - Displays the diversified hourly load per customer.

Total - Displays the total of all of the diversified hourly load values (summation of the total hourly load
values).

Total Hourly Usage - Displays the total diversified hourly load (hourly load per customer times the number
of customers).
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Command Buttons

Calculate - Calculates the associated values.

Clear - Sets all of the data items to blank (null) values.

Close - Closes the screen and saves the current data values.

Print - Displays the Print Settings screen to print the data values and. if calculated, the results.

Notes & Considerations

! The hourly load values are calculated as described in the GASWorkS User’s Manual.

! The hourly load calculation is performed when a quantity value is changed and the Enter key is pressed,
when an item is selected from one fo the dimensional units lists, or when the Calculate command button is
clicked.

! The number of digits displayed to the right of the decimal indicator for the calculated hourly values is
controlled by the Customer Load Values item found on the Decimals data tab on the Report Options screen.
Select the Report Options item from the Report menu to change or view the current settings.
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Pipe Segment Calculator Report

The report is accessed by clicking the Print command button on the Pipe Segment Calculator screen. The
features associated with the report are described as follows.

Displayed Items

Pipe Segment Calculator Report - Displays the Pipe Segment Calculator Report. To browse the display,
adjust the vertical scroll bar adjacent to the display area.

Icons

Copy To Clipboard - Copies the contents of the Pipe Segment Calculator Report to the Windows
Clipboard. Once copied, the contents may be pasted into another application.
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Maximize Screen Size - Increases the Pipe Segment Calculator Report’s size to fill the
GASWorkS display.

Print - Displays the Print Settings screen and allows contents of the Pipe Segment Calculator
Report to be printed.

Reset Screen Size - Sets the Pipe Segment Calculator Report’s size to its “normal” dimensions
and position.

Command Buttons

Close - Closes the Pipe Segment Calculator Report.

Notes & Considerations

! If the Pipe Segment Calculator Report is too wide to print, set the printer to use landscape mode, and
reduce the printer font size. If no adjustment is made to the report’s width, the report will be printed on
multiple pages.
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Pipe Segment Calculator

A routine is provided to calculate the various hydraulic values for a single pipe segment. To perform the
calculation, select the Calculate Pipe Segment Values item from the Analysis menu. The features associated
with the screen are described as follows.

Pipe Data Tab

Data Items

Diameter - Specifies or displays the inside diameter value or Size/Type Code of the pipe segment.

Efficiency - Specifies or displays the hydraulic efficiency of the pipe segment.

Equation - Specifies the pipe flow equation to use to calculate the unknown values.

Flow Rate - Specifies or displays the volumetric flow rate through the pipe segment.

Inlet Elevation - Specifies the elevation at the inlet (upstream) end of the pipe segment.
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Inlet Pressure - Specifies or displays the pressure at the inlet (upstream) end of the pipe segment.

Inlet Temperature - Specifies the temperature at the inlet (upstream) end of the pipe segment.

Length - Specifies or displays the base hydraulic length of the pipe segment.

Outlet Elevation - Specifies the elevation at the outlet (downstream) end of the pipe segment.

Outlet Pressure - Specifies or displays the pressure at the outlet (downstream) end of the pipe segment.

Outlet Temperature - Specifies the temperature at the outlet (downstream) end of the pipe segment.

Roughness - Specifies or displays the inside pipe wall roughness of the pipe segment. This item is only
available for pipe flow equations that use roughness in their calculation.
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Other Data Tab

Data Items

Attached Fittings - Displays the fittings that are attached to the pipe segment.

Available Fittings - Specifies the fittings found in the currently selected Fittings Table.

Fittings Table - Specifies the Fitting Property Table to use with the calculation.

Notes - Displays any descriptive notes or comments to be associated with the calculation. Enter any desired
notes by typing them into the associated data panel.

Sizing Group - Specifies the “Sizing Group” type (as listed in the Pipe Property Table) to use with the
calculation. This item is only displayed when the Diameter item is being calculated.

Sizing Type - Specifies the “Use When Sizing” type (as listed in the Pipe Property Table) to use with the
calculation. This item is only displayed when the Diameter item is being calculated.

Calculated Values

Additional Length - Displays the additional hydraulic length associated with the equivalent length of the
attached fittings. This item is displayed on the Other Data tab.

Average Pressure - Displays the average pressure of the pipe segment.

Composite Sizes - When the Diameter item is selected to be calculated, displays the composite sizes and
lengths which would result in a pressure drop value that would nominally match the specified pressure
values.
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Compressibility - Displays the compressibility factor for the gas contained in the pipe segment. The value
is based on the Average Pressure and Average Temperature values associated with the segment.

Inside Diameter - When a Size/Type Code is used for the Diameter item, displays the inside diameter (as
listed in the current Pipe Property Table) associated with the selected Size/Type Code.

Line Volume - Displays the amount of gas contained in the pipe segment.

Maximum Velocity - Displays the maximum velocity of the gas flow through the pipe segment. This always
occurs at the downstream end (outlet) of the pipe segment.

Pressure Drop - Displays the calculated pressure drop across the pipe segment.

Command Buttons

Calculate - Calculates the associated values and value of the unknown (underlined) parameter.

Clear Attached Fittings List - Removes all of the items from the Attached Fittings list. 

Close - Closes the screen and saves the current data values.

Print - Displays the Print Settings screen to print the data values and. if calculated, the results.

Swap Pressures - Exchanges the inlet and outlet pressure values for the pipe segment.

Notes & Considerations

! The item labels shown in red indicate the specific pipe items which can be calculated. The item that is
underlined indicates that the item is being calculated. To change the calculated item (underlined item), click
on the desired red label, until the item is underlined. Only one of the red labels can be underlined at a time.

! On the Other Data tab, to add an item to the Attached Fittings, select an item from the Available Fittings
list. To remove an item, double-click on the desired item to be removed.

! The gas properties used by the calculation are taken from the Gas Properties values set in the Default Data
Values associated with the currently open model.

! The base temperature and base pressure used by the calculation are taken from the Solution Data
associated with the currently opened model.

! The calculated values are based on the equations which are described in the GASWorkS User’s Manual.
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Title Block Definition

The UK Design Module version of the GASWorkS software provides support for plots to be created using
a User defined Title Block and a User defined sheet layout. The Title Block consists of a General Settings
section which can include a logo and address, and an Item Descriptions section which can consist of a
number of User defined elements. To modify the Title Block Definition, select the Title Block Definition item
from the Edit menu. The features associated with the screen are described as follows.

General Settings Tab

Data Items

Dimensional Units - Specifies the dimensional units to use for the dimensional values entered in the
definition.

Font Size - Specifies the size (in printer points) for the text displayed in the Title Block.

Line Spacing - Specifies the line spacing for the text displayed in the Title Block.
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Logo Image Height - Specifies the height of the logo image as displayed in the Title Block. See the
following Notes & Considerations section for additional information on setting the logo image size.

Logo Image Name - Specifies the name of the image file to use for the logo associated with the Title Block.
The inclusion of a logo is optional. To unassign an logo image file, select the “empty” or blank item from
the list. See the following Notes & Considerations section for additional information on using logo image
files.

Logo Image Width - Specifies the width of the logo image as displayed in the Title Block. See the following
Notes & Considerations section for additional information on setting the logo image size.

Logo Position - Specifies the horizontal position of the logo in relation to the Title Block or associated
section of the Title Block. The available values are described in the following table:

Item Value Description

Center The logo will be centered in the Title Block (for vertical orientation) or the
associated section of the Title Block (for horizontal orientation).

Left The logo will be placed along the left side of the Title Block (for vertical
orientation) or the associated section of the Title Block (for horizontal
orientation).

Right The logo will be placed along the right side of the Title Block (for vertical
orientation) or the associated section of the Title Block (for horizontal
orientation).

Logo Text - Line (1, 2, ...) - Specifies the text value to be displayed on the plot output. The number of logo
text line items will vary according to the Logo Text Line Count value.

Logo Text Line Count - Specifies the number of lines of text to associate with the logo. See the following
Notes & Considerations section for additional information on working with logo text.

Number Of Sections - Specifies the number of sections to be created for a horizontally oriented Title Block.
A horizontally oriented Title Block can be segregated into separate “sections”. Sections are separated by a
vertical line. This item is only enabled when the Title Block Orientation item is set to a “Horizontal” value.

Title Block Height - Specifies the height of a horizontally oriented Title Block. This item is only enabled
when the Title Block Orientation item is set to a “Horizontal” value.

Title Block Orientation - Specifies the orientation and location of the Title Block on the plotted sheet. The
available values are described in the following table:
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Item Value Description

Horizontal - Bottom The Title Block is oriented horizontally along the bottom of the plotted
sheet.

Horizontal - Top The Title Block is oriented horizontally along the top of the plotted
sheet.

Vertical - Left The Title Block is oriented vertically along the left side of the plotted
sheet.

Vertical - Right The Title Block is oriented vertically along the right side of the plotted
sheet.

Title Block Width - Specifies the width of a vertically oriented Title Block. This item is only enabled when
the Title Block Orientation item is set to a “Vertical” value.
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Item Descriptions Tab

Displayed Items

Item # - Displays the item count number. This item is internally assigned and cannot be changed by the User.

Data Items

Display Color - Specifies the color to display the associated item with. If “Click To Select Color...” is
selected, the Color Palette will be displayed. Select the desired color, then click the OK command button.

Fixed Text Value - Specifies the text value to be displayed adjacent to the “Fixed Text” item.

Item ID - Specifies a unique identification reference for the definition item.

Item Label - Specifies the text value to be displayed in the Title Block for the associated item. This item is
applicable to all Item Types except “Section Break” and “Blank Line” types.
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Item Type - Specifies the “type” of the associated item. The available Item Types are described in the
following table:

Item Value Description

Blank Line Represents a single line entry in the Title Block. No text will be
displayed. The height/spacing of the line will be as specified by the
associated User Graphic Line Thickness value.

Current Date Represents a single line entry in the Title Block. The specified label
text will be displayed in the Title Block followed by the current
operating system date. The date will be displayed in the currently
selected operating system date format.

Data Item - Multiline Represents a multiline entry in the Title Block. The specified label text
will be displayed in the Title Block followed by the specified number
of User entered values. During the Plot routine, a screen will be
displayed to allow entry of data values for data type items.

Data Item - Single Line Represents a single line entry in the Title Block. The specified label
text will be displayed in the Title Block followed by a User entered
value. During the Plot routine, a screen will be displayed to allow
entry of data value for the data type items.

Fixed Text Value Represents a single line entry in the Title Block. The specified label
text will be displayed in the Title Block followed by the specified text
value.

Plot Scale Value Represents a single line entry in the Title Block. The specified label
text will be displayed in the Title Block followed by the currently
selected plot scale value.

Section Break Causes a new section (column) to be created in a horizontally oriented
Title Block. Ignored in a vertically oriented Title Block.

User Graphic Line Represents a single line entry in the Title Block. The specified label
text will be displayed in the Title Block followed by a horizontal line
displayed using the specified User Graphic Line Style and Thickness.

User Graphic Line &
Symbol

Represents a single line entry in the Title Block. The specified label
text will be displayed in the Title Block followed by a horizontal line
drawn using the specified User Graphic Line Style and Thickness, and
a symbol displayed using the specified User Graphic Symbol Style,
Rotation, and Width.
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Item Value Description

User Graphic Symbol Represents a single line entry in the Title Block. The specified label
text will be displayed in the Title Block followed by a symbol
displayed using the specified User Graphic Symbol Style, Rotation,
and Width.

Multiline Count - If the Item Type is “Data Item - Multiline”, specifies the number of text lines for the
associated item.

Underline Item - Specifies the associated item will be underlined with a horizontal line.

Underline Width - Specifies the width (thickness in pixels) of the displayed line.

User Graphic Line Style - If the Item Type is a “User Graphic Line” or “User Graphic Line & Symbol”,
specifies the line style to be used to display the User Graphic Line.

User Graphic Line Width - If the Item Type is “User Graphic Line” or “User Graphic Line & Symbol”,
specifies the width (thickness in pixels) of the displayed User Graphic Line. If the Item Type is “Blank Line”,
specifies the line spacing (height) of the blank line, specified as a factored line spacing (for example 0.5, 1.0,
or 1.5).

User Graphic Symbol Rotation - If the Item Type is “User Graphic Symbol” or “User Graphic Line &
Symbol”, specifies the orientation (in degrees clockwise from north) to display the User Graphic Symbol.

User Graphic Symbol Style - If the Item Type is “User Graphic Symbol” or “User Graphic Line & Symbol”,
specifies the symbol style to be used to display the User Graphic Symbol.

User Graphic Symbol Width - If the Item Type is “User Graphic Symbol” or “User Graphic Line &
Symbol”, specifies the width (thickness in pixels) of the line work used to display the User Graphic Symbol.

Icons

Add Item - Adds a new item to the end of the definition. This icon is only displayed when the
Item Descriptions data tab is displayed.

Delete Item - Deletes the currently selected (highlighted) item. This icon is only displayed when
the Item Descriptions data tab is displayed.
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Insert Item - Inserts a new item just before the currently selected (highlighted) item. This icon
is only displayed when the Item Descriptions data tab is displayed.

Maximize Screen Size - Increases the Title Block Definitions screen’s size to fill the GASWorkS
display.

Move Item - Moves the currently selected (highlighted) item to a new location in the definition.
When clicked, a message will be displayed to select the new location. Click the OK command
button to clear the message, then select the desired location. This icon is only displayed when the
Item Descriptions data tab is displayed.

Open - Opens a previously saved Title Block Definition file (.tdf). When clicked, the File
Selection screen is displayed.

Print - Prints the contents of the currently displayed data tab. When clicked, the Print Settings
screen is displayed.

Reset Screen Size - Sets the Title Block Definitions screen’s size to its “normal” dimensions and
position.

Save - Saves the contents of the currently displayed definition. When clicked, the File Selection
screen is displayed. Once saved, the file can be opened and used with other models.

Command Buttons

Cancel - Closes the screen without saving changes.

Close - Closes the screen and save changes.

Notes & Considerations

! The following should be considered when using an image file to create a logo for a Title Block:

• The file must be in a Windows bitmap (.bmp) or JPEG (.jpg) format. Other format files may be
used, but must first be converted into a supported format.
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• The image file must be saved in the currently assigned Property Tables directory. Use the Paths
item from the Preferences submenu of the File menu to change the current setting.

• The Plot routine will shrink or stretch the specified image to fit the specified logo size dimensions.
Using a large size image for a small size logo, or vice versa, can yield unattractive results. It may be
necessary to manipulate the image size using a third party application before using it in the Title
Block.

! If a logo image file is selected, the image size is forced to fit the specified logo size as entered in the Title
Block Definition. If the height is specified and the width is not specified (set to 0), the logo will be displayed
using the specified height, and the display width will be adjusted to maintain the proportions of the original
image. If the width is specified and the height is not specified (set to 0), the logo will be displayed using the
specified width, and the display height will be adjusted to maintain the proportions of the original image. If
both the height and width are specified, the image will be stretched or shrunk to fit the specified dimensions.

! The logo text refers to a group of text to be associated with the logo position. Generally, the logo text
might include a company name and address, but can include any User desired text. The specified text items
will be included each time the Title Block is plotted. In that sense the logo text is considered “fixed” in the
context of the Title Block Definition. To exclude the logo text from the Title Block, set the Logo Text Line
Count to zero (0).

! Sample Title Block Definitions are provided when the UKDM software is installed. The definitions are
normally installed in the standard GASWorkS Property Table directory (“support\definitions”).

! To include a Title Block in the plot results, select the Include Title Block (Requires Title Block Definition)
item in the Settings data tab on the Plot Settings screen.
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! Some of the various Title Block features are shown in the following figure:
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Title Block Values

If the Include Title Block (Requires Title Block Definition) option is selected on the Plot Settings screen, the
Title Block Values screen will be displayed during the Plot routine. The screen allows selection of the Title
Block Definition to use and allows entry of data values if Single or Multiline data items are included in the
selected Title Block Definition. The features of the screen are described as follows.

Data Items

Data Values - If Single or Multiline data items are included in the Title Block Definition, the label
associated with each data item will be listed in the Item column.

Title Block Definition Filename - Specifies the filename of the Title Block Definition to use during the Plot
routine.
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Command Buttons

Cancel - Closes the screen and returns to the Plot Settings screen.

Continue - Proceeds with the Plot routine.

Open - Opens previously saved Title Block data values from another model or project.

Notes & Considerations

! The Title Block Definition Filename list includes the definitions found in the currently selected Property
Tables path. Use the Paths item from the Preferences submenu of the File menu to view or change the path
settings.

! When data values are opened from another model, the data values are compared to the currently selected
Title Block Definition. When a data value identification is found in the selected model that matches an data
value identification in the current model, the associated data value is assigned to the current model.
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DATA PANEL
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Customer Data & Results

The Customer Data, as used with the UK Design Module, is essentially the same as the one used with the
standard version of GASWorkS, however the Attribute Data Values and Actions sections are handled in a
unique manner with the UKDM. The unique items are described as follows.

Attribute Data Values

The Attribute Data Values section contains items found in the linked Attribute Data file. The data values are
segregated into sections. If multiple attribute segments are associated with the customer, they are listed in
separate sections of the list, and each data item is followed by the associated “segment” number. The
calculated data is contained in a separate section.
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Data Items

Address - Specifies the street name of the address for the customer. This item can contain 40 alphanumeric
characters.

Address Number - Specifies the address number for the customer. This item can contain 40 alphanumeric
characters.

Alias - Specifies an alternative description, name, or address for the customer. This item can contain 40
alphanumeric characters.

Allow Sizing Calculation - Specifies whether the service line for the customer can be sized or is a fixed
(entered) value. If this item is set to “Yes - Single Size Service”, the service line size to be calculated uses
the smallest acceptable pipe size. If this item is set to “Yes - Composite Sized Service”, the service line size
to be calculated uses a combination of pipe sizes and lengths.

Allowable Pressure Drop - Specifies the maximum allowable pressure drop for the entire service line (from
connection to termination). This item is required for the Service Line Sizing calculation.

Connection Type - Specifies the type of connection between the service line and the main. This item is
required for the Service Line Sizing calculation.

Hourly Demand - Specifies the hourly demand value to be used to size the service line for the customer.
This item is required for the Service Line Sizing calculation.

Hourly Demand Units - Specifies the dimensional units for the Hourly Demand value.

Housing Type - Specifies the meter housing type. This item is attribute only - there is no affect on service
line sizing.

Include In Report - Specifies whether the customer feature will be included in the Assumption &
Authorisation Report.

Meter Type - Specifies the meter type. This item is attribute only - there is no affect on service line sizing.

Product Type - Specifies the service type for the customer. This item is attribute only - there is no affect
on service line sizing.

Service Type - Specifies the product type for the customer. This item is attribute only - there is no affect on
service line sizing.

Termination Type - Specifies the type of the connection between the service line and the meter. This item
is required for the Service Line Sizing calculation.
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Segment Data -

Attached Fitting - Specifies the fittings that may be installed along the associated service line.

Joint Type - 1, 2... - Specifies the type of method used to join the pipe for the associated segment.
This item is attribute only - there is no affect on service line sizing. 

Orientation - 1, 2... - Specifies the orientation style for the associated segment. This item is attribute
only - there is no affect on service line sizing. 

Ownership - 1, 2... - Specifies the ownership type for the associated segment. This item is attribute
only - there is no affect on service line sizing. 

Packaging Type - 1, 2... - Specifies the type of pipe packaging used for the associated segment. This
item is attribute only - there is no affect on service line sizing.

Pipe Length - 1, 2... - Specifies the base hydraulic length to be used for the segment in the sizing
calculation. This item is required for the Service Line Sizing calculation. 

Pipe Size - 1, 2... - Specifies the size of the associated service line segment. If the Allow Sizing
Calculation item is set to “Yes” and the service line size has been calculated, specifies the resulting
size. If the segment is associated with a composite service, the value will indicate the larger size of
the service. This item can contain 20 alphanumeric characters.

Reinstatement Method - 1, 2... - Specifies the surface reinstatement method for the associated
segment. This item is attribute only - there is no affect on service line sizing. 

Sizing Group - 1, 2... - Specifies the sizing (material) group to be used when calculating the service
size for the segment. This item is required for the Service Line Sizing calculation. 

Surface Category - 1, 2... - Specifies the surface category for the associated segment. This item is
attribute only - there is no affect on service line sizing.

Calculated Values
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Displayed Items

Allowable Velocity - Displays the maximum allowable velocity value through the service line.

Inlet Pressure - Displays the inlet pressure for the service line (pressure at the main connection).

Maximum Velocity - Displays the maximum calculated velocity value for the service line.

Outlet Pressure - Displays the outlet pressure for the service line (pressure at the termination).

Pressure Drop - Displays the pressure drop across the entire service line.

Segment Data -

Inlet Pressure - 1, 2... - Displays the inlet pressure for the associated segment.

Outlet Pressure - 1, 2... - Displays the outlet pressure for the associated segment.

Velocity - 1, 2... - Displays the maximum velocity of the gas flow through the associated segment.

Actions

The Actions section contains several items which may be used to initiate a command or routine unique to UK
Design Module. See the GASWorkS User’s Manual for a description of the standard Actions associated with
the Customer Data.

Action UKDM GDI Command - See Description

Calculate All Service Sizes Calculate All Service Sizes
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Action UKDM GDI Command - See Description

Calculate Graphic Length Causes the Pipe Length item(s) to be set to their graphic
lengths. The pipe segment lengths can be manually entered.
Use this item to reset the length values to the original graphic
lengths.

Calculate Hourly Demand Causes the Hourly Demand item to be calculated as follows.
If the Node Load Application is set to something other than
“Diversified”, the Per Unit Load is used as the basis for the
Hourly Demand and converted to the specified dimensional
units. If the Node Load Application is set to “Diversified”,
the Per Unit Load and Heating Type are used to compute the
Hourly Demand using the appropriate diversity calculation
method and a Customer Count of one.

Calculate Service Size Causes the Pipe Size item(s) to be calculated. The method
used to calculate the service size is described later in this
guide.

Notes & Considerations

! The UKDM data and calculated items found in the attribute data are described in the following table. The
contents of the list are defined by the associated Attribute Database Definition. Information on how to view
and revise the definition contents are described later in this guide.

Customer Data

Item Name Description Data Type

Miscellaneous Data Values

Pipe Facility Type Displays the Facility Type of the main that the
customer is connected to. The customer inherits the
Facility Type of the main it is connected to.

Calculated Item

Note - If a composite service is calculated, the selected composite sizes and lengths will be displayed in
the calculated data associated with the segment where the size changes, as described in the “Composite
Related Items” section of this table.
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Customer Data

Item Name Description Data Type

Governor Related Items

Additional data items are included in the Attribute Data Values section if a governor is associated with
the service line/customer. They are described as follows...

Allowable Minimum
Pressure

Specifies the minimum allowable pressure for the
inlet to the governor. Required for Service Line
Sizing calculation.

Single Precision
Number

Allowable Pressure
Drop - Dn

Specifies the maximum allowable pressure drop for
the portion of the service line between the outlet of
the governor and the service termination. Required
for Service Line Sizing calculation.

Single Precision
Number

Allowable Pressure
Drop - Up

Specifies the maximum allowable pressure drop for
the portion of the service line between the main
connection and the inlet to the governor. Required for
Service Line Sizing calculation.

Single Precision
Number

Governor Set Pressure Specifies the set pressure of the governor. Required
for Service Line Sizing calculation.

Single Precision
Number

Governor Type Specifies the governor type. Attribute only - does not
affect service line sizing.

Listed Item

Additional items are included in the Calculated Values section when a governor is associated with the
service line/customer. They are described as follows...

Allowable Pressure Drop Displays the maximum allowable pressure drop
across the entire service line.

Calculated Item

Allowable Velocity Displays the maximum allowable velocity value
through the service line.

Calculated Item

Inlet Pressure - Dn Displays the inlet pressure for the portion of the
service line downstream of the governor (pressure at
the governor outlet). 

Calculated Item

Inlet Pressure - Up Displays the inlet pressure for the portion of the
service line upstream of the governor (pressure at the
main connection). 

Calculated Item
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Customer Data

Item Name Description Data Type

Maximum Velocity - Dn Displays the maximum velocity of the gas flow
through the portion of the service line between the
governor outlet and the termination.

Calculated Item

Maximum Velocity - Up Displays the maximum velocity of the gas flow
through the portion of the service line between the
main connection and the governor inlet.

Calculated Item

Outlet Pressure - Dn Displays the outlet pressure for the portion of the
service line downstream of the governor (pressure at
the termination).

Calculated Item

Outlet Pressure - Up Displays the outlet pressure for the portion of the
service line upstream of the governor (pressure at the
governor inlet).

Calculated Item

Pressure Drop - Dn Displays the pressure drop across the portion of the
service line between the governor outlet and the
termination.

Calculated Item

Pressure Drop - Up Displays the pressure drop across the portion of the
service line between the main connection and the
governor inlet. 

Calculated Item

Composite Related Items

If a composite service is calculated, the selected composite sizes and lengths will be displayed in the
calculated data associated with the segment where the size changes.

Composite Size X.1 Specifies the larger composite size, where “X” is
equal to the segment number.

Calculated Item

Composite Length X.1 Specifies the portion of the segment length associated
with the larger composite size, where “X” is equal to
the segment number.

Calculated Item

Composite Size X.2 Specifies the smaller composite size, where “X” is
equal to the segment number.

Calculated Item

Composite Length X.2 Specifies the portion of the segment length associated
with the smaller composite size, where “X” is equal
to the segment number.

Calculated Item

 B3PE LLC                                                                                          Engineering & Software Services
Revision - 002, Copyright 2021, All Rights Reserved.

87



GASWorkSTM 10.1 Data Panel
Table Of Contents

Customer Data

Item Name Description Data Type

If a composite service is calculated, a summary of the selected composite sizes and total lengths will be
displayed in the calculated data associated with the service.

Composite Size - 1 Specifies the larger composite size. Calculated Item

Total Composite
Length - 1

Specifies the total length of the larger composite size. Calculated Item

Composite Size - 2 Specifies the smaller composite size. Calculated Item

Total Composite
Length - 2

Specifies the total length of the smaller composite
size.

Calculated Item

Notes
• The dimensional units for pressure related items are based on the dimensional unit used for the
lowest pressure node associated with the pipe that the customer is connected to.
• The dimensional units for velocity related items are based on the velocity unit selected in the Default
Data Values dimensional units.
• The dimensional units for length related items are set by the length unit selected in the Default Data
Values dimensional units.
• A service line can be segregated into a maximum of ten attribute segments.
• The “Listed Item” data type indicates that the item’s value is selected from a data list. In the case of
non-standard items, the associated list is specified in the Attribute Database Definition.
• The “Calculated Item” data type refers to an item whose value is derived or calculated.
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Pipe Data & Results

The Pipe Data, as used with the UK Design Module, is essentially the same as the one used with the standard
version of GASWorkS, however the Attribute Data Values and Actions sections are handled in a unique
manner with the UKDM. The unique items are described as follows.

Attribute Data Values

The Attribute Data Values section contains items found in the linked Attribute Data file. The data values are
segregated into sections. If multiple attribute segments are associated with the pipe, they are listed in separate
sections of the list, and each data item is followed by the associated “segment” number.

Data Items

Note - See the following Notes & Considerations section for a table describing additional the unique UKDM
Attribute Data Values data items.

Address - Specifies the street name of the address for the pipe/main. This item can contain 40 alphanumeric
characters.
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Address Number - Specifies the address number for the pipe/main. This item can contain 40 alphanumeric
characters.

Alias - Specifies an alternative description, name, or address for the pipe/main. This item can contain 40
alphanumeric characters.

Connection Size - Specifies the Size/Type Code of the pipe/main that the current pipe is connected to. This
item is attribute only - there is no affect on service line sizing.

Connection Type - Specifies the type/method of the connection between the current pipe/main and another
pipe/main. This item is attribute only - there is no affect on service line sizing. To include the equivalent
length of a connection, attach an appropriate “fitting” in the Attached Fittings section.

Include In Report - Specifies whether the pipe/main feature will be included in the Assumption &
Authorisation Report.

Product Type - Specifies the service type for the pipe/main. This item is attribute only - there is no affect
on service line sizing.

Segment Data -

Joint Type - 1, 2... - Specifies the type of method used to join the pipe for the associated segment.
This item is attribute only - there is no affect on service line sizing.

Orientation - 1, 2... - Specifies the orientation style of the associated segment. This item is attribute
only - there is no affect on service line sizing.

Ownership - 1, 2... - Specifies the ownership type for the associated segment. This item is attribute
only - there is no affect on service line sizing.

Packaging Type - 1, 2... - Specifies the type of pipe packaging used for the associated segment. This
item is attribute only - there is no affect on service line sizing.

Pipe Length - 1, 2... - Specifies the attribute length for the segment. This item is attribute only -
there is no affect on service line sizing.

Reinstatement Method - 1, 2... - Specifies the surface reinstatement method for the associated
segment. This item is attribute only - there is no affect on service line sizing.

Surface Category - 1, 2... - Specifies the surface category for the associated segment. This item is
attribute only - there is no affect on service line sizing.
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Actions

The Actions section contains several items which may be used to initiate a command or routine unique to UK
Design Module. See the GASWorkS User’s Manual for a description of the standard Actions associated with
the Pipe Data.

Action UKDM GDI Command - See Description

Calculate Graphic Length Causes the Pipe Length item to be set to the
graphic length. The pipe segment length can be
manually entered. Use this item to reset the
length values to the original graphic length.

Notes & Considerations

! The UKDM allows the length of each attribute segment to be entered individually. These values are not
required to represent the base hydraulic length. The Hydraulic Length value entered in the Hydraulic Data
Items section represents the base hydraulic length used with the hydraulic calculations.

! The data and calculated items found in the attribute data are described in the following table. The contents
of the list are defined by the associated Attribute Database Definition. Information on how to view and revise
the definition contents are described later in this guide.

Pipe Data

Item Name Description Data Type

Miscellaneous Data Values

Customer Count Displays the number of customers attached to the pipe.
This item refers to the number of actual connections, and
does not include additional “customers” associated with
multi-unit customers.

Calculated Item

Facility Type Identifies the Facility Type assigned to the main. Listed Item
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Pipe Data

Item Name Description Data Type

Notes
• The dimensional units for length related items are set by the Length dimensional unit selected in the
Default Data Values.
• A pipe/main can be segregated into a maximum of five attribute segments.
• A “Listed Item” data type indicates that the item’s value is selected from a data list. In the case of
non-standard items, the associated list is specified in the Attribute Database Definition.
• A “Calculated Item” data type refers to an item whose value is derived or calculated.
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GRAPHIC DATA

INTERFACE (GDI)
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The UK Design Module uses the basic GASWorkS Graphic Data Interface (GDI) Window, and supplements
it with several additional GDI Commands. See the GASWorkS User’s Manual for information and
descriptions for the standard GDI features. The UKDM features are described on the following pages.

GDI Commands & Icon Descriptions

Add Service Attribute Marker - Adds a vertex to an existing customer service line and sets it
as an attribute marker. Executing this command will cause a series of prompts to appear to select
the customer to add the service vertex to and the new vertex location.

Toolbar: Customer Commands
    GDI Command Line: ADDSATT, ADDSERVICEATT

Add Service Governor - Adds a governor to an existing customer service line. Executing this command will
cause a series of prompts to appear to select the customer to add the service governor to, the governor
location, and then information about the governor.

Toolbar: None
GDI Command Line: ADDSERVICE

Add User Text - Predefined - Adds a User Text feature from an ASCII text file (.txt). Executing this
command will cause a series of prompts to appear to identify the User Text location, rotation, height, width,
and the ASCII text file to use. Note - The contents of the Predefined User Text Filename list are those files
found in the “support\images” directory (folder) of the GASWorkS root directory (folder).

Toolbar: None
GDI Command Line: ADDPREDEFINEDTEXT, ADDPT

Calculate All Service Sizes - Calculates the service line sizes for all of the customer features in
the model. Executing this command will cause the service line sizes to be calculated for all of the
customers in the model. A message will be displayed when the calculation is complete.

Toolbar: None - Icon in lower-right corner of GDI Window
    GDI Command Line: CALCALLSIZES, CALCULATEALLSIZES

Convert DXF Line To Pipe - Converts a line displayed in a DXF background image to a pipe feature.
Executing this command will cause a persistent prompt to appear to identify the DXF line(s) to convert to
pipe features. To end the selection process, right-click the mouse. The selected DXF lines will be converted
to pipe features. Note - Only Arc, Line, and Polyline type background entities may be converted to a pipe
feature.

Toolbar: None
GDI Command Line: CONVERTDXF, DXF2PIPE
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Convert DXF Line To Pipe - Offset - Creates a pipe feature from a line displayed in a DXF background
image and allows the pipe location to be offset from the original line location. Executing this command will
cause a persistent prompt to appear to identify the DXF line(s) to convert to pipes. To end the selection
process, right-click the mouse. A prompt will be displayed to specify the offset distance and direction. Note -
Only Arc, Line, and Polyline type background entities may be converted to a pipe.

Toolbar: None
GDI Command Line: CONVERTDXFOFF, DXFOFFPIPE

Copy Pipe - Offset - Copies an existing pipe feature and offsets it at a User specified value. Executing this
command will cause a series of prompts to appear to identify the pipe to be copied, the offset distance, and
the offset side of the original pipe. A new pipe will be placed at the offset location with the same data values
as the selected “base” pipe.

Toolbar: None
GDI Command Line: OFFPIPE, OFFSETPIPE

Create Bill Of Materials - Creates a Bill Of Materials for the pipe features, fittings, valves, tees, and
governors in a model. Executing this command will cause the Bill Of Materials table to be displayed.

Toolbar: None
GDI Command Line: CREATEBOM

Delete Bill Of Materials Table - Deletes the Bill Of Materials Table. Executing this command will cause
a message to be displayed asking whether to really delete the Bill Of Materials Table - respond appropriately.

Toolbar: None
GDI Command Line: DELBOMT, DELETEBOMTABLE

Delete Service Governor - Deletes an existing service governor from a customer service line. Executing this
command will cause a prompt to appear to identify the customer to delete the governor from.

Toolbar: None
GDI Command Line: DELETESERVICE, DELSERV

Highlight DXF Entity - Highlights a User selected DXF entity and displays information about the selected
entity. Executing this command will cause a prompt to appear to identify the DXF entity to be selected.
Select an entity and a message will be displayed listing information about the selected entity. Note -
Highlighting a DXF entity is useful to identify which layer an entity is on or when trying to determine an
entities graphical type.

Toolbar: None
GDI Command Line: HIGHLIGHTDXF, HILITDXF

Match Customer Attribute Properties - Assigns the attribute data values from one customer feature to
another customer feature. Executing this command will cause a series of prompts to appear to identify the
“base” customer and the customer(s) to assign the base values to.

Toolbar: None
GDI Command Line: MATCHCATT, MATCHCUSTOMERATTRIBUTE
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Match Pipe Attribute Properties - Assigns the attribute data values from one pipe feature to another pipe
feature. Executing this command will cause a series of prompts to appear to identify the “base” pipe and the
pipe(s) to assign the base data values to.

Toolbar: None
GDI Command Line: MATCHPATT, MATCHPIPEATTRIBUTE

Move Bill Of Materials Table - Moves the Bill Of Materials Table. Executing this command will cause a
series of prompts to appear to identify the “base point” for the Bill Of Materials Table and the new location.
The Bill Of Materials Table will be placed at the selected location.

Toolbar: None
GDI Command Line: MOVEBOM

Set Pipe Attribute Marker - Sets an existing polyline pipe vertex as a pipe attribute marker.
Executing this command will cause a series of prompts to appear to identify the pipe associated
with the vertex to be changed and the vertex to set as an attribute marker.

Toolbar: Graphic Edit Commands
    GDI Command Line: SETPATT, SETPIPEATTRIBUTE

Set Service Attribute Marker - Sets an existing service vertex as a service attribute marker.
Executing this command will cause a series of prompts to appear to identify the customer
associated with the vertex to be changed and the vertex to set as an attribute marker.

Toolbar: Customer Commands
    GDI Command Line: SETSERVATT, SETSERVICEATTRIBUTE

Set Service Governor Location - Sets an existing service vertex as a governor location marker. Executing
this command will cause a series of prompts to appear to identify the customer to be changed, the vertex to
set as a governor location, along with additional prompts for information about the governor.

Toolbar: None
GDI Command Line: SETSERVICELOC

Unset Pipe Attribute Marker - Removes the attribute marker setting from an existing pipe
vertex (attribute marker). Executing this command will cause a series of prompts to appear to
identify the pipe associated with the vertex to be changed and the vertex/marker to be unset.

Toolbar: Graphic Edit Commands
    GDI Command Line: UNSETPATT, UNSETPIPEATT

Unset Service Attribute Marker - Removes the attribute marker setting from an existing service
vertex (attribute marker). Executing this command will cause a prompt to appear to identify the
customer associated with the vertex to be changed and the vertex/marker to unset.

Toolbar: Customer Commands
    GDI Command Line: UNSETSATT, UNSETSERVICEATT
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Add A Service Attribute Marker

Summary

! Adds a vertex to an existing customer service line and sets it as an attribute marker.

Example

This example assumes that GASWorkS has already been started, that a model is open, that the GDI Window
is open, and that at least one customer feature is present in the model.

! Click the Add Service Attribute Marker icon from the Customer Commands Toolbar.

! At the Select Customer To Add Service Vertex To prompt, move the mouse pointer near
the desired customer feature and left-click the mouse.

! If the customer feature has a polyline service line, at the Select Service Segment To Add Vertex
To prompt, move the mouse pointer near the desired vertex and left-click the mouse.

! At the New Vertex Location prompt, move the mouse crosshairs to the desired location and left-
click the mouse.

! A service attribute marker will be placed at the entered or selected location.

Notes & Considerations

! This command can also be executed by selecting the Add Service Attribute Marker item from the GDI
Command List, or by typing ADDSERVICEATT or ADDSATT on the GDI Command Line and pressing
the Enter key.

! To delete or move the location of an attribute marker, use the Delete Service Line Vertex or Move Service
Line Vertex commands respectively.

! The Display Vertex Symbols graphic settings option can be used to turn the vertex symbols “on” or “off”.

! If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon
to restore the last data or graphic change. To access the option, select the Settings item from the Preferences
submenu from the File menu.
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Add A Service Governor

Summary

! Adds a governor to an existing customer service line.

Example

This example assumes that GASWorkS has already been started, that a model is open, that the GDI Window
is open, and that at least one customer feature is present in the model.

! Select the Add Service Governor item from the GDI Command List.

! At the Select Customer To Add Service Governor To prompt, move the mouse pointer
near the desired customer feature and left-click the mouse.

! If the customer feature is a polyline service line, at the Select Service Segment To Add Governor
To prompt, move the mouse pointer near the desired service line segment and left-click the mouse.

! At the Select Governor Location prompt, move the mouse crosshairs to the desired location and
left-click the mouse. A service governor will be placed at the entered or selected location.

! At the Governor Type prompt, select an item from the GDI Prompt List.

! At the Governor Set Pressure prompt, enter the desired value by typing it on the GDI Prompt Line
and press the Enter key.

Notes & Considerations

! This command can also be executed by typing ADDSERVICE on the GDI Command Line and pressing
the Enter key.

! To remove a service governor from the model, use the Delete Service Governor command.

! If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon
to restore the original configuration. To access the option, select the Settings item from the Preferences
submenu from the File menu.
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See Also

Delete A Service Governor
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Add Predefined User Text

Summary

! Adds a User Text feature from an ASCI text file (*.txt).

Example

The example assumes that GASWorkS has been started, a model is open, the GDI Window is displayed, and
a predefined ASCII text file (*.txt) has been saved to the “support\text” folder in the GASWorkS directory.

! Select the Add User Text - Predefined item from the GDI Command List.

! At the Text Insert Location prompt, either type a coordinate pair on the GDI Prompt
Line and press the Enter key, or move the mouse crosshairs to a point in the GDI Display
and left-click the mouse. The selected location will be the lower-left corner of the User Text Feature.

! At the User Text Rotation prompt, move the mouse crosshairs to a point within the GDI Display
and left-click the mouse. The angle of the line that is displayed in the GDI Display indicates the
orientation of the User Text feature.

! At the User Text Height prompt, move the mouse crosshairs to a point within the GDI Display and
left-click the mouse. The text height will be set to the length of the line that is displayed in the GDI
Display.

! At the User Text Width prompt, move the mouse crosshairs to a point within the GDI Display and
left-click the mouse. The width of the User Text feature will be set equal to the length of the line that
is displayed in the GDI Display.

! At the Predefined User Text Filename, select a Filename from the GDI Prompt List.

! The selected “.txt” file will be turned into a User Text feature and displayed at the selected
location.

Notes & Considerations

! This command can also be executed by typing ADDPREDEFINEDTEXT or ADDPT on the GDI
Command Line and pressing the Enter key.

! An ASCII text file may be created in any text editor application, such as Windows Notepad.
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! To turn the display of User Text features “on” or “off”, use the Display User Text command.

! To change the User Text Data, either use the Edit User Text command or left-click on the desired User
Text feature to display the data in the Data Panel.

! To create a copy of an existing User Text feature, use the Copy User Text command.

! To change the location of a User Text feature, either use the Move User Text command or grips.

! To remove a User Text feature from the model, use the Delete User Text command.

! If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon
to restore the original configuration. To access the option, select the Settings item from the Preferences
submenu from the File menu.
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Calculate All Service Sizes

Summary

! Calculates the service line sizes for all of the customer features in the model.

Example

This example assumes that GASWorkS has already been started, that a model is open, that the GDI Window
is open, and that at least one customer feature is present in the model.

! Click the Calculate All Service Sizes icon from the lower-right corner of the GDI Window.

! If changes have been made to the model since the last solution, a message will be
displayed asking whether to continue - either click the Yes command button to proceed,
or click the No command button to cancel the routine.

! A message may be displayed when the service size calculation is complete. Click the OK
command button to clear the message.

Notes & Considerations

! This command can also be executed by selecting the Calculate All Service Sizes item from the GDI
Command List, or by typing CALCALLSIZES or CALCULATEALLSIZES on the GDI Command Line and
pressing the Enter key.

! If the model has not been solved since the last change was made (the model is “unbalanced”), the
summation symbol on the Calculate All Service Sizes icon will be colored red.

! If no changes have been made to the model since the last solution (the model is “balanced”),
the summation symbol on the Calculate All Service Sizes icon will be colored blue.
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Convert A DXF Line To A Pipe

Summary

! Converts a line displayed in a DXF background image to a pipe feature.

Example

This example assumes that GASWorkS has already been started, that a model is open, that the GDI Window
is open, and that a DXF background image is attached to the model.

! Select the Convert DXF Line To Pipe item from the GDI Command List.

! At the Select A DXF Line prompt, move the mouse pointer to the desired DXF line and
left-click the mouse.

! The Select Another DXF Line prompt will be displayed. Either continue to select additional DXF
lines with the method described above, or if no additional DXF lines are to be converted, either
right-click the mouse button or press the “E” key to end the selection process. Note - To unselect
(unhighlight) a DXF line, move the mouse pointer near the undesired DXF line and left-click the
mouse.

! A message will be displayed asking whether to convert all of the highlighted DXF lines - respond
appropriately.

! Note - If a new node is created and the Allow Data Entry During New Feature Entry graphic
settings option is selected, the Node Data will be displayed in the Data Panel. Right-click the mouse
to accept the default data values. If changes are made, click the Apply Data Values command button.

! Note - If the Allow Data Entry During New Feature Entry graphic settings option is selected, the
Pipe Data will be displayed in the Data Panel. Right-click the mouse to accept the default data
values. If changes are made, click the Apply Data Values command button.

Notes & Considerations

! This command can also be executed by typing CONVERTDXF or DXF2PIPE on the GDI Command Line
and pressing the Enter key.

! Only Arc, Line, and Polyline type background entities can be converted to a pipe feature.
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! If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon
to restore the original configuration. To access the option, select the Settings item from the Preferences
submenu from the File menu.
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Convert A DXF Line To A Pipe & Offset The Pipe

! Creates a pipe feature from a line displayed in a DXF background image and allows the pipe location to
be offset from the original line location.

Example

This example assumes that GASWorkS has already been started, that a model is open, that the GDI Window
is open, and that a DXF background image is attached to the model.

! Select the Convert DXF Line To Pipe - Offset item from the GDI Command List.

! At the Select A DXF Line prompt, move the mouse pointer to the desired DXF line and
left-click the mouse.

! At the Offset Distance prompt, enter the desired value by typing it on the GDI Prompt Line and
press the Enter key.

! At the Select Side To Offset To prompt, move the mouse pointer to the desired side of the original
DXF line and left-click the mouse.

! Note - If a new node is created and the Allow Data Entry During New Feature Entry graphic
settings option is selected, the Node Data will be displayed in the Data Panel. Right-click the mouse
to accept the default data values. If changes are made, click the Apply Data Values command button.

! Note - If the Allow Data Entry During New Feature Entry graphic settings option is selected, the
Pipe Data will be displayed in the Data Panel. Right-click the mouse to accept the default data
values. If changes are made, click the Apply Data Values command button.

Notes & Considerations

! This command can also be executed by typing CONVERTDXFOFF or DXFOFFPIPE. on the GDI
Command Line and pressing the Enter key.

! Only Arc, Line, and Polyline type background entities can be converted to a pipe feature.

! If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon
to restore the original configuration. To access the option, select the Settings item from the Preferences
submenu from the File menu.
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Convert Service Lines To Customers

! Converts a pipe feature assigned to a specified Facility Type from a DXF layer to a customer symbol and
service line.

Example

This example assumes that GASWorkS has already been started, that a model is open, that the GDI Window
is open, and that a DXF background image is attached to the model.

! Select the Convert Service Lines To Customers item from the GDI Command List.

! At the Facility Type Associated With Service Lines prompt, select the desired item from
the GDI Prompt List and press the Enter key.

! At the Fuzzy Tolerance prompt, enter the desired value by typing it on the GDI Prompt Line and
press the Enter key.

! A message may be displayed stating how many service lines were processed and the number of
customers added. Click the OK command button to clear the message.

Notes & Considerations

! This command can also be executed by typing CONVERTSERVICE or SERVICE2CUST on the GDI
Command Line and pressing the Enter key.

! If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon
to restore the original configuration. To access the option, select the Settings item from the Preferences
submenu from the File menu.
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Copy A Pipe & Offset

Summary

! Copies an existing pipe feature and offsets it at a User specified value.

Example

This example assumes that GASWorkS has already been started, that a model is open, that the GDI Window
is open, and that at least one pipe feature is present in the model.

! Select the Copy Pipe - Offset item from the GDI Command List.

! At the Select A Pipe prompt, move the mouse pointer to the desired pipe feature to copy
and left-click the mouse.

! At the Offset Distance prompt, enter the desired value by typing it on the GDI Prompt Line and
press the Enter key.

! At the Select Side To Offset To prompt, move the mouse pointer to the desired side of the original
pipe feature and left-click the mouse.

! A copy of the selected pipe will be places at the specified offset distance from the original pipe
location.

Notes & Considerations

! This command can also be executed by typing OFFPIPE or OFFSETPIPE on the GDI Command Line and
pressing the Enter key.

! If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon
to restore the original configuration. To access the option, select the Settings item from the Preferences
submenu from the File menu.
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Create A Bill Of Materials

Summary

! Creates a Bill Of Materials for the pipe features, Fittings, Valves, tees, and governors in a model. 

Example

This example assumes that GASWorkS has already been started, that a model is open, that the GDI Window
is open, and that at least one customer service line and one pipe feature are present in the model.

! Select the Create Bill Of Materials item from the GDI Command List.

! If a Bill Of Materials already exists, a message will be displayed asking to recreate it
now - respond appropriately.

! The Bill Of Materials Report will be displayed. Browse the contents of the Bill Of Materials and
make any desired changes. When finished, click the Close command button.

Notes & Considerations

! This command can also be executed by typing CREATEBOM on the GDI Command Line and pressing
the Enter key.

! To insert the Bill Of Materials into the model, use the Insert As Table icon on the Report.

! If the Bill Of Materials has been inserted into the model and the location needs to be changed, use the
Move Bill Of Materials Table command.

! If the Bill Of Materials has been inserted into the model and the table needs to be removed, use the Delete
Bill Of Materials command.

See Also

Delete The Bill Of Materials Table
Move The Bill Of Materials Table
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Delete The Bill Of Materials Table

Summary

! Deletes the Bill Of Materials Table.

Example

This example assumes that GASWorkS has already been started, that a model is open, that the GDI Window
is open, and that a Bill Of Materials Table is present in the model.

! Select the Delete Bill Of Materials Table item from the GDI Command List.

! The Bill Of Materials Table will be deleted.

Notes & Considerations

! This command can also be executed by typing DELBOMT or DELETEBOMTABLE on the GDI
Command Line and pressing the Enter key.

! If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon
to restore the original configuration. To access the option, select the Settings item from the Preferences
submenu from the File menu.

See Also

Create A Bill Of Material
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Delete A Service Governor

Summary

! Deletes an existing service governor from a customer service line.

Example

This example assumes that GASWorkS has already been started, that a model is open, that the GDI Window
is open, and that at least one customer feature with a service governor is present in the model.

! Select the Delete Service Governor item from the GDI Command List.

! At the Select Customer To Delete Governor From prompt, move the mouse pointer
near the desired customer to delete the service governor from and left-click the mouse.

! The selected service governor will be deleted from the associated customer feature.

Notes & Considerations

! This command can also be executed by typing DELETESERVICE or DELSERV on the GDI Command
Line and pressing the Enter key.

! If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon
to restore the original configuration. To access the option, select the Settings item from the Preferences
submenu from the File menu.

See Also

Add A Service Governor
Unset A Service Attribute Marker
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Highlight A DXF Entity

Summary

! Highlights a User selected DXF entity and displays information about the selected entity.

Example

This example assumes that GASWorkS has already been started, that a model is open, that the GDI Window
is open, and that a DXF background image is present in the model.

! Select the Highlight DXF Entity item from the GDI Command List.

! At the Select An Entity prompt, move the mouse pointer near the desired DXF entity
to highlight and left-click the mouse.

! A message will be displayed showing the DXF entity information. Click the OK command button
to clear the message.

! The Select Another Entity prompt will be displayed. Either continue to select additional DXF
entities with the method described above, or if no additional DXF entities are to be highlighted,
either right-click the mouse button or press the “E” key to end the selection process.

Notes & Considerations

! This command can also be executed by typing HIGHLIGHTDXF or HILITDXF on the GDI Command
Line and pressing the Enter key.
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Match The Customer Attribute Properties

Summary

! Assigns the attribute data values from one customer feature to another customer feature.

Example

This example assumes that GASWorkS has already been started, that a model is open, that the GDI Window
is open, that customer attribute data is attached, and that at least one customer feature is present in the model.

! Select the Match Customer Attribute Properties item from the GDI Command List.

! At the Select Base Customer prompt, move the mouse pointer to the desired customer
feature to copy the attribute properties from and left-click the mouse.

! At the Select Customer To Change... prompt, either move the mouse pointer near the desired
customer(s) to change and left-click the mouse, or either right-click the mouse button or press the
“E” key to end the selection process.

! The associated customer attribute features will be copied to the selected customer features.

Notes & Considerations

! This command can also be executed by typing MATCHCATT or MATCHCUSTOMERATTRIBUTE on
the GDI Command Line and pressing the Enter key.

! If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon
to restore the original configuration. To access the option, select the Settings item from the Preferences
submenu from the File menu.
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Match The Pipe Attribute Properties

Summary

! Assigns the attribute data values from one pipe feature to another pipe feature.

Example

This example assumes that GASWorkS has already been started, that a model is open, that the GDI Window
is open, that pipe attribute data is attached, and that at least one pipe feature is present in the model.

! Select the Match Pipe Attribute Properties item from the GDI Command List.

! At the Select Base Pipe prompt, move the mouse pointer to the desired pipe feature to
copy the attribute properties from and left-click the mouse.

! At the Select Pipe To Change... prompt, either move the mouse pointer near the desired pipe(s)
to change and left-click the mouse, or either right-click the mouse button or press the “E” key to end
the selection process.

! The associated pipe attribute features will be copied to the selected pipe features.

Notes & Considerations

! This command can also be executed by typing MATCHPATT or MATCHPIPEATTRIBUTE on the GDI
Command Line and pressing the Enter key.

! If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon
to restore the original configuration. To access the option, select the Settings item from the Preferences
submenu from the File menu.
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Move The Bill Of Materials Table

Summary

! Moves the Bill Of Materials Table.

Example

This example assumes that GASWorkS has already been started, that a model is open, that the GDI Window
is open, and that at least one Bill Of Materials Table is present in the model.

! Select the Move Bill Of Materials Table item from the GDI Command List.

! At the Select Base Point On Group prompt, move the mouse crosshairs to the desired
location on the Bill Of Materials Table to use as the “base” point and left-click the
mouse.

! At the Select New Location prompt, move the mouse crosshairs to the desired location for the
moved Bill Of Materials Table and left-click the mouse.

! The Bill Of Materials Table will be moved to the selected location.

Notes & Considerations

! This command can also be executed by typing MOVEBOM on the GDI Command Line and pressing the
Enter key.

! To insert a Bill Of Materials Table into a model, use the Create Bill Of Materials command, then use the
Insert As Table icon.

! If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon
to restore the original configuration. To access the option, select the Settings item from the Preferences
submenu from the File menu.

See Also

Create A Bill Of Materials
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Set A Pipe Attribute Marker

Summary

! Sets an existing polyline pipe vertex as a pipe attribute marker.

Example

This example assumes that GASWorkS has already been started, that a model is open, that the GDI Window
is open, and that at least one polyline pipe feature is present in the model.

! Select the Set Pipe Attribute Marker icon from the Graphic Edit Commands Toolbar.

! At the Select Pipe To Set Vertex For prompt, move the mouse pointer to the desired
pipe feature and left-click the mouse. The selected pipe feature will be highlighted.

! At the Select A Vertex To Set As An Attribute Marker prompt, move the mouse pointer to the
desired vertex and left-click the mouse.

! The selected pipe vertex will now be set as an attribute marker.

Notes & Considerations

! This command can also be executed by selecting the Set Pipe Attribute Marker item from the GDI
Command List, or by typing SETPATT or SETPIPEATTRIBUTE on the GDI Command Line and pressing
the Enter key.

! To remove an individual pipe attribute marker, use the Unset Pipe Attribute Marker command.

! If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon
to restore the original configuration. To access the option, select the Settings item from the Preferences
submenu from the File menu.

See Also

Unset A Pipe Attribute Marker
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Set A Service Attribute Marker

Summary

! Sets an existing service vertex as a service attribute marker.

Example

This example assumes that GASWorkS has already been started, that a model is open, that the GDI Window
is open, and that at least one polyline customer feature is present in the model.

! Click the Set Service Attribute Marker icon from the Customer Commands Toolbar.

! At the Select Customer To Set Service Vertex For prompt, move the mouse pointer to
the desired customer feature and left-click the mouse.

! At the Select A Vertex To Set As An Attribute Marker prompt, move the mouse pointer to the
desired vertex and left-click the mouse.

! The selected service vertex will now be set as an attribute marker.

Notes & Considerations

! This command can also be executed by selecting the Set Service Attribute Marker item from the GDI
Command List, or by typing SETSERVATT or SETSERVICEATTRIBUTE on the GDI Command Line and
pressing the Enter key.

! To remove an individual service attribute marker, use the Unset Service Attribute Marker command.

! If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon
to restore the original configuration. To access the option, select the Settings item from the Preferences
submenu from the File menu.

See Also

Unset A Service Attribute Marker
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Set A Service Governor Location

Summary

! Sets an existing service vertex as a governor location marker.

Example

This example assumes that GASWorkS has already been started, that a model is open, that the GDI Window
is open, and that at least one polyline service customer feature with a service vertex is present in the model.

! Select the Set Service Governor Location item from the GDI Command List.

! At the Select Customer To Assign Service Governor To prompt, move the mouse
pointer to the desired customer feature and left-click the mouse.

! At the Select The Vertex Immediately Upstream Of The Governor Location prompt, move the
mouse pointer to the desired vertex and left-click the mouse.

! At the Governor Type prompt, select the desired item from the GDI Prompt List.

! At the Governor Set Pressure prompt, enter the desired value by typing it on the GDI Prompt Line
and press the Enter key.

! The selected vertex will be set to a service governor.

Notes & Considerations

! This command can also be executed by typing SETSERVICELOC on the GDI Command Line and
pressing the Enter key.

! If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon
to restore the original configuration. To access the option, select the Settings item from the Preferences
submenu from the File menu.

 B3PE LLC                                                                                          Engineering & Software Services
Revision - 002, Copyright 2021, All Rights Reserved.

121



GASWorkSTM 10.1 Help Examples
Table Of Contents

Unset A Pipe Attribute Marker

Summary

! Removes the attribute marker setting from an existing pipe vertex (attribute marker).

Example

This example assumes that GASWorkS has already been started, that a model is open, that the GDI Window
is open, and that a pipe feature with a vertex set as an attribute marker is present in the model.

! Click the Unset Pipe Attribute Marker icon from the Graphic Edit Commands Toolbar.

! At the Select Pipe To Unset Vertex For prompt, move the mouse pointer to the desired
pipe feature and left-click the mouse.

! At the Select A Vertex To Unset As An Attribute Marker prompt, move the mouse pointer to the
desired vertex and left-click the mouse.

! The selected vertex attribute marker will now be a vertex.

Notes & Considerations

! This command can also be executed by selecting the Unset Pipe Attribute Marker item from the GDI
Command List, or by typing UNSETPATT or UNSETPIPEATT on the GDI Command Line and pressing
the Enter key.

! If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon
to restore the original configuration. To access the option, select the Settings item from the Preferences
submenu from the File menu.

See Also

Set A Pipe Attribute Marker
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Unset A Service Attribute Marker

Summary

! Removes the attribute marker setting from an existing service vertex (attribute marker).

Example

This example assumes that GASWorkS has already been started, that a model is open, that the GDI Window
is open, and that a customer feature with a service vertex set as an attribute marker is present in the model.

! Click the Unset Service Attribute Marker icon from the Graphic Edit Commands
Toolbar.

! At the Select Customer To Unset Service Vertex For prompt, move the mouse pointer
to the desired customer feature and left-click the mouse.

! At the Select A Vertex To Unset As An Attribute Marker prompt, move the mouse pointer to the
desired vertex and left-click the mouse.

! The selected vertex attribute marker will now be a vertex.

Notes & Considerations

! This command can also be executed by selecting the Unset Service Attribute Marker item from the GDI
Command List, or by typing UNSETSATT or UNSETSERVICEATT on the GDI Command Line and
pressing the Enter key.

! If the Allow Undo Of Data/Graphic Changes preference settings option is enabled, click the Undo icon
to restore the original configuration. To access the option, select the Settings item from the Preferences
submenu from the File menu.

See Also

Set A Service Attribute Marker
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Attribute Files

Many of the UK Design Module features rely heavily on the use of specially defined linked attribute files.
Separate files are provided for the main and service features. The attribute file definition can be viewed and
edited using the associated Attribute File Settings screen. 

To view the Customer or Pipe Attribute File Definition associated with an open model or project, select the
Attribute File item from the Customer Data or Pipe Data submenu of the Utilities menu. The associated
Attribute File Settings screen will be displayed. To view the Database Definition, select the Other data tab
on the screen, and the definition settings and assignments will be displayed. 

To edit the definition, click the Edit Attribute Database Definition command button from the Attribute File
Settings screen. The Linked Attribute Database Definition screen will be displayed. Only the items whose
cell color is “white”, may be changed by the User. The UKDM expects certain fields to be present. It is not
advisable to delete any of the original fields. Making a change to the definition associated with the currently
open model or project, only affects that model or project.

A “seed” attribute file is used when creating a new project. The seed file contains a base definition that is
used to create the definition for the new project. To make a change that will affect the definition for all new
projects, the definition contained in the seed file must be changed. In the case of Customer Data, the
“standard” seed file is named “ukdm_def_c”. In the case of Pipe/Main Data, the “standard” seed file is named
“ukdm_def_p”. Although the “standard” seed definition may be altered by the User, it is suggested that if
a change is made to the original seed definition, that it be saved to another name. The seed file is assigned
to a project when it is created using the New Project routine, by selecting the Attach A Linked Customer
Attribute File or Attach A Linked Pipe Attribute File item, then selecting the desired definition name from
the associated list.

Additional information on working with Attribute File Definitions is contained in the GASWorkS User’s
Manual.
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Attribute Lists

Some of the items found in the attribute data for the pipe/mains and services is supported by use of an
associated attribute list. The lists contain acceptable values for each associated item. The lists are assigned
to an item using the Database Definition.

An attribute list can represent a standard GASWorkS dimensional unit list, Property Table, or custom
attribute value/code list. In general, a custom attribute list is a specifically formatted ASCII text file. The
format of the file contains a value to be displayed to the User and a code to be used by the software.

Special custom lists have been created and are associated with the UK Design Module. These lists can be
modified by the User, however if the lists are not correctly formatted, they can become corrupt and the
UKDM features may not function correctly. The GASWorkS User’s Manual contains additional information
on working with Attribute Lists.
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Attribute Markers

Attribute markers are used to segregate a main or a service into segments. Each segment may have unique
attribute values and settings. An attribute marker is a specially designated pipe or service vertex. Additional
information on how they apply to main and services is described on the following pages.

The display of vertex markers for pipe/main and customer features is controlled using the Display Vertex
Symbols item. To view or change the settings, select the Settings item from the Graphics menu.

Main Attribute Markers

As used with main features, attribute markers are used to segregate a main into a maximum of five segments,
without causing the need for additional nodes. Each segment may have unique attribute values and settings.
Attribute markers do not affect the sizing of pipes/mains.

Add An Attribute Marker To A Main

To set an existing pipe vertex as an attribute marker -

! Click the Set Pipe Attribute Marker icon from the Graphic Edit Commands Toolbar.
Select the pipe containing the desired vertex, then select the desired pipe vertex. If the
vertex markers are displayed, the vertex shape will change to a diamond (instead of a
triangle) to indicate that the vertex represents an attribute marker.

To add an attribute marker at a location where a pipe vertex does not already exist -

 ! Click the Add Polyline Pipe Vertex icon from the Graphic Edit Commands Toolbar.
Select the pipe to add the vertex to, then select the location for the vertex/marker.

! Once the vertex has been added, click the Set Pipe Attribute Marker icon from the
Graphic Edit Commands Toolbar. Select the pipe containing the new vertex, then select
the desired pipe vertex. If the vertex markers are displayed, the vertex shape will change
to a diamond (instead of a triangle) to indicate that the vertex represents an attribute
marker.
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Delete An Attribute Marker From A Main

To delete an attribute marker along with its associated vertex from a main -

! Click the Delete Polyline Pipe Vertex icon from the Graphic Edit Commands Toolbar.
Select the desired pipe, then select the desired vertex.

To delete an attribute marker without deleting the associated vertex from a main -

 ! Click the Unset Pipe Attribute Marker icon from the Graphic Edit Commands Toolbar.
Select the desired pipe, then select the desired marker to unset. If the vertex markers are
displayed, the vertex shape will change to a triangle (instead of a diamond).

Service Attribute Markers

As used with service features, attribute markers are used to segregate a service into a maximum of ten
segments. Each segment may have unique attribute values and settings. Depending on the value of the various
attribute values, attribute markers along a service may affect the sizing of the service line.

Add A Service Attribute Marker

To set an existing vertex as an attribute marker -

! Click the Set Service Attribute Marker icon from the Customer Commands Toolbar.
Select the desired customer, then select the desired service vertex. If the vertex markers
are displayed, the vertex shape will change to a diamond (instead of a triangle) to indicate
that the vertex represents an attribute marker.

To add a vertex and automatically set it as an attribute marker -

! Click the Add Service Attribute Marker icon from the Customer Commands Toolbar.
Select the desired customer, then select the location of the new vertex/marker. If the vertex
markers are displayed, the new vertex location will be marked with a diamond shape to
indicate that the vertex represents an attribute marker.
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Delete A Service Attribute Marker

To delete an attribute marker along with its associated vertex from a service -

! Click the Delete Service Line Vertex icon from the Customer Commands Toolbar. Select
the desired customer, then select the desired vertex/marker.

To delete an attribute marker without deleting the associated vertex from the service -

! Click the Unset Service Attribute Marker icon from the Customer Commands Toolbar.
Select the desired customer, then select the desired vertex/marker. If the vertex markers
are displayed, the vertex shape will change to a triangle (instead of a diamond).
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Diversity Calculations

The diversity calculations used by the UK Design Module are the same calculations used by the standard
version of GASWorkS. The calculations are based on Appendix 4 and 5 of IGE/GL/1. As implemented in
GASWorkS, diversity can be used for both treed or looped piping systems, and the model can be comprised
of both diversified and non-diversified customers/loads. Additional information on the use and
implementation of the diversity calculations can be found in the GASWorkS User’s Manual.
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Facility Settings

Facility Settings can be used to segregate features based on the Facility Type value. The Facility Settings can
only be assigned to a main feature - nodes and services inherit the value of the associated main. With respect
to the UK Design Module, the most important use of the Facility Settings is with respect to the Pipe Sizing
routine. Individual pipe segments may be included or excluded from the Pipe Sizing process, depending on
the assigned Facility Settings. Additional information on working with Facility Settings is contained in the
GASWorkS User’s Manual.

 B3PE LLC                                                                                          Engineering & Software Services
Revision - 002, Copyright 2021, All Rights Reserved.

133



GASWorkSTM 10.1 Miscellaneous
Table Of Contents

Service Size Calculations

In general the service size calculation method used by the UK Design Module is similar to the method used
to size pipes/mains. The process attempts to satisfy the specified pressure and velocity requirements by
selecting allowable pipe sizes from the currently specified Pipe Property Table, for the services that are
allowed to be calculated. The process is described more fully below.

Pipe Property Table

The currently specified Pipe Property Table is used to select the allowable pipe sizes. The Pipe Property
Table is specified using the Property Tables item from the Preferences submenu of the File menu. Only
pipes where the Use When Sizing item is set to “Services” or “Both” are used in the Service Sizing process,
and of those pipes, only the ones that meet the specified Sizing Group assignment are used. In the UKDM,
Sizing Groups (Group 1, Group 2, etc) are assigned to common group names such as MDPE, HDPE, etc. The
assignment is made through the use of the Sizing Group attribute list. Additional information on the use of
the attribute lists is presented later in this guide.

For example, if a service line is set to be sized (“Allow Sizing Calculation” Customer Attribute Data Values
item is set to “Yes”) and set to use MDPE (“Sizing Group” Attribute Data Values item is set to “MDPE”),
only pipes associated with the Sizing Group Number assigned to the MDPE attribute code (Group 1) and set
to allow to use when sizing services, will be used during the Pipe Sizing process.

For an “Existing” Sizing Group attribute code, no assignment will be made and the associated service
segment will not be sized.

Attribute Segments

The service line may be segregated into attribute segments. An attribute segment is created by adding an
Attribute Marker (special service line vertex) at the location where a change in attribute information for the
service line occurs. The Sizing Group may be uniquely set for each individual segment. For example, one
segment could be set as “Existing” to represent a section of existing service under the street and would not
be sized. Another segment could be set to “MDPE” to represent a section of new underground service, and
another segment could be set to “Steel” to represent a new above ground riser section. Each segment of the
service line will be sized according to its assigned Sizing Group.

Use the Add Service Attribute Marker, Set Service Attribute Marker, and Unset
Service Attribute Marker commands to manage the attribute segments for a
service line.
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Design Requirements

The service line sizing is based on specified pressure and velocity requirements. The pressure requirement
is set individually for each service, and can be set as either a maximum allowable pressure drop, or in the
case of a service with a governor, a minimum allowable inlet pressure. The allowable pressure requirements
are set using the Customer Attribute Data. The maximum velocity is set at 15 Metres/sec. The velocity limit
cannot be revised by the User.

Customer Attribute Data

Several attribute items need to be set in order to facilitate the Service Sizing process. See the Customer Data
& Results topic in the Data Panel section in this guide for additional information on the description and use
of the various Customer Attribute Data items. The required items are described as follows.

Attached Fittings

This item establishes the type of fittings used along the associated service segment. Use of the item is
optional, however if a fitting is attached, the appropriate equivalent length will be included in the overall
hydraulic length during the Service Sizing process. Select an appropriate value from the associated list.

Connection Type

This item establishes the type of connection to the main line. Based on the selected type, the appropriate
equivalent length will be included in the overall hydraulic length during the Service Sizing process. Select
an appropriate value from the associated list.

Hourly Demand

The Hourly Demand item specifies the flow value to be used during the Service Sizing. Generally, the value
should indicate the maximum anticipated hourly demand for the service line. If the value is not set, the Per
Unit Load value in the Hydraulic Data Items is used during the Service Sizing process. If the Node Load
Application is set to “Diversified”, the load value is computed as the “Diversified” load based on the
specified heating type and annual usage for a customer count of one. Either enter an appropriate value, or
enter an appropriate Per Unit Load value and select the Calculate Hourly Demand item from the Actions list.
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Hourly Demand Units

The Hourly Demand Units item specifies the dimensional unit to be used for the flow values used during the
Service Sizing. Select an appropriate dimensional unit from the associated list.

Pipe Length

The Pipe Length represents the base hydraulic length. Additional equivalent length values are added to this
value as fittings, connections, and terminations are assigned to the service line. The initial value of this item
is set to the graphic (scaled) length of the service line as drawn in the GDI Window. The value can be
overridden by manually entering a value. The value can be reset to the graphic length by selecting the
Calculate Graphic Length item from the Actions list. Either leave the assigned value, or enter an appropriate
value.

Sizing Group

This item establishes the type of pipe to be used to size the associated segment of the service line. Select an
appropriate value from the associated list.

Pipe Length

This item establishes the type of termination used at the meter location. Based on the selected type, the
appropriate equivalent length will be included in the overall hydraulic length during the Service Sizing
process. Select an appropriate value from the associated list.
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Sizing Process

The sizing process varies according to the service line configuration. The general configurations supported
by the sizing process are a single service line, a dualed/branched service line (a single trunk line which
branches into two service lines), and either a single or branched service line which has an intermediate
governor installed along the line between the main connection and termination (for a single service) or the
branch connection (for a branch service). The procedures used by the Sizing routine for each specific
configuration are described as follows.

Single Service

! A single service refers to a service line connected to the main line, extending to a single termination,
without an intermediate governor installed along the line. The procedure for sizing a single service is:

! The lowest pressure for the nodes associated with the main that the service line is attached to is
determined. This pressure is used as the inlet pressure for the service line.

! The total hydraulic length for the service line is computed based on the service length, connection
type, termination type, and any attached fittings.

! A minimum required service line size is computed. The size is based on the velocity and pressure
requirements, the hourly load value, the total hydraulic length, and the assigned Sizing Group.

! If the minimum required size represents that smallest size available for use in the assigned Sizing
Group, the service size is set to the computed minimum required size.

! If the minimum required size is greater than the smallest size available for the assigned Sizing
Group, and the total service length (not hydraulic length) is less than 63 Metres, the service size is
set to the computed minimum required size.

! If the minimum required size is greater than the smallest size available for the assigned Sizing
Group, and more than one Sizing Group is assigned to the service line, the service size is set to the
computed minimum required size.

! If the minimum required size is greater than the smallest size available for the assigned Sizing
Group, and the total service length (not hydraulic length) is greater than 63 Metres, and only one
Sizing Group is assigned to the service line, and the next smaller available size can satisfy the
velocity requirements, and the customer is set to allow calculation of a composite sized service, an
attempt is made to compute a “composite service”. Otherwise, the service size is set to the computed
minimum required size.
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! A composite sized service is one that contains two different pipe sizes. The length of each size is computed
such that the specified pressure drop requirements are nominally met. The composite service calculation is
performed as follows:

! The next smaller available size for the assigned Sizing Group is determined.

! The required length of each size is determined so that the pressure requirements are nominally
satisfied. The length values are determined to within 0.1 Metre. Because of this limit, the pressure
requirements may not be exactly satisfied.

! If the length of the smaller size is less than 30% of the overall service length (not hydraulic
length), the service size is set to the computed minimum required size (larger composite size).

! If the length of the smaller size is 30% or more of the overall service length (not hydraulic length),
the service sizes are set as a composite and the composite lengths are assigned.

! If the length of the larger size is less than 0.1 Metre, it is set to 0.1 Metre.

! When a composite service is calculated, the equivalent length of the connection is based on the larger size,
the equivalent length of the termination is based on the smaller size, the equivalent length of any attached
fittings is based on the size for the associated segment, except where the segment corresponds to the location
where the size changes (composite size transition segment). In that case, the equivalent length of the fittings
attached to that segment, is based on the smaller size.

Dualed/Branched Service

! A dualed or branched service refers to a service line that has a single connection to the main, continues
for some distance, then branches into two separate lines that each continue to different termination points.
The portion of the main between the tap and branch connection is referred to as the “approach” or “trunk”
portion of the service. The portion of the service between the branch connection and termination is referred
to as the “branch” portion of the service line. 

! With respect to the sizing calculations, the branches are further differentiated as the “trunk branch” and
the “branch”. When a branch customer is created, the “trunk” customer is entered, then the branch customer
is entered and the point where the branch customer connects to the trunk is identified. The trunk branch is
that portion of the original trunk service that is downstream of the branch connection.

! The procedure for sizing a branched service is:

! The lowest pressure for the nodes associated with the main that the service line is attached to is
determined. This pressure is used as the inlet pressure for the service line.
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! The total hydraulic length for each portion of the service line - trunk, trunk branch, and branch -
is computed based on the service length, connection type, termination type, and any attached fittings.
The connection of the branch to the trunk is assumed to be made by the branch leg of a line tee. The
line tee is assumed to be the same size as the trunk portion of the service. The appropriate equivalent
length value is included for the branch portions of the service line.

! A minimum required size is computed for the trunk portion of the service line. The size is based
on the velocity and pressure requirements, the total hourly load value (the sum of the loads for both
customers), the total hydraulic length for that portion of the service, and the assigned Sizing Group.

! The trunk branch and branch portions of the service are then sized. The size is selected based on
the velocity and pressure requirements, each portion’s respective load, hydraulic length, and the
assigned Sizing Group. These portions of the service line are sized similar to the sizing method used
for a single service.

Service With Governor

! A governor can be included in either a single or dualed service. A governor is used to reduce a higher
pressure supply from the main to a lower pressure on the remainder of the service downstream of the
governor.

! With respect to the sizing calculations, a service containing a governor is differentiated into two portions -
the high pressure portion (the portion upstream of the governor, between the main line connection and the
governor inlet), and the low pressure portion (the portion downstream of the governor, between the governor
outlet and the termination(s).)

! The procedure for sizing a service with a governor is:

! The lowest pressure for the nodes associated with the main that the service line is attached to is
determined. This pressure is used as the inlet pressure for the high pressure portion of the service
line.

! The total hydraulic length is calculated for each portion of the service line as described in the
single and dualed service line configurations.

! The high pressure portion of the service line is sized using the associated pressure requirements,
etc, similar to the method described for a single service line.

! The set pressure for the governor is used as the inlet pressure for the low pressure portion of the
service line. The low pressure portion of the service is sized using the associated pressure
requirements, etc, similar to the method described for either a single or dualed service line.
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Fittings, Connections, & Terminations

The equivalent length values of the fittings, connections, and terminations used in the service size
calculations are “hard-coded” within the GASWorkS software. The hard-coded values are equivalent to the
values listed in the standard UKDM Fitting Property Table that is provided when the software is installed.
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Working With GASWorkS 8.0 Data

A GASWorkS 8.0 model can be imported to a GASWorkS 10 model by opening the associated model using
the Open item in the File menu. When a GASWorkS 8.0 model is detected using the Open routine, a prompt
will appear requesting whether to import the file or not, respond to the prompt appropriately.

The GASWorkS 8.0 model data will be imported into the new GASWorkS 10 model format. The main and
customer attribute data will be imported into the Linked UK Attribute file format. Not all GASWorkS 8.0
attribute data is supported in GASWorkS 10, some data will be lost in the translation.
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Working With GASWorkS 10 Data

A GASWorkS 7.0 and 9.0 model can be imported to a GASWorkS 10 model by using the Import and Export
routines, or by opening the associated model using the Open item in the File menu. When a GASWorkS 7.0
or 9.0 model is detected using the Open routine, a prompt will appear requesting whether to import the file
or not, respond to the prompt appropriately. If the Open routine suspects that diversity load calculations were
used with the original model, and that customer features were not used in the model, an additional prompt
will appear. An affirmative response to the prompt will allow entry of the required diversity data. Diversity
calculation data was not saved with the model data in GASWorkS 7.0 or 9.0.

The GASWorkS 7.0 and 9.0 model data will be imported into the new GASWorkS 10 model format. If a
GASBase style attribute file was used with the original model, the main and customer attribute data will be
imported into a predefined Linked Attribute file format, similar in content to the original GASBase file. The
GASBase type attribute file format is not compatible with the UKDM features.
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Include the quotation marks. There are spaces between Program and Files, between Files and
(x86), between GASWorkS and 10, and between the closing quote (”) and the forward slash (/).

Note...

Disabling UKDM Features

For Windows XP, 7, Vista: Select the Windows Start button. The program menu list will be displayed.
Select the Run item from the program list.

For Windows 8: From the Windows 8 desktop, right-click the mouse pointer in the lower-left corner of the
desktop. Select the Run item from the menu list.

For Windows 10: From the Windows 10 desktop, right-click the mouse pointer on the Windows icon in the
lower-left corner of the desktop. Select the Run item from the menu list.

At the Open prompt, type “\Program Files (x86)\GASWorkS 10\app\gasworks.exe” /-sp. Click
the OK command button.

The described procedure will only temporarily disable the UK Design Module features. Start GASWorkS
in the normal manner to enable the UKDM features again.
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